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Send Us Your Comments

Oracle® Retail Process Orchestration and Monitoring User Guide

Oracle welcomes customers' comments and suggestions on the quality and usefulness of this
document.

Your feedback is important, and helps us to best meet your needs as a user of our products.
For example:

• Are the implementation steps correct and complete?

• Did you understand the context of the procedures?

• Did you find any errors in the information?

• Does the structure of the information help you with your tasks?

• Do you need different information or graphics? If so, where, and in what format?

• Are the examples correct? Do you need more examples?

If you find any errors or have any other suggestions for improvement, then please tell us your
name, the name of the company who has licensed our products, the title and part number of
the documentation and the chapter, section, and page number (if available).

Note

Before sending us your comments, you might like to check that you have the latest
version of the document and if any concerns are already addressed. To do this,
access the Online Documentation available on the Oracle Technology Network Web
site. It contains the most current Documentation Library plus all documents revised or
released recently.

Send your comments to us using the electronic mail address: retail-doc_us@oracle.com

Please give your name, address, electronic mail address, and telephone number (optional).

If you need assistance with Oracle software, then please contact your support representative
or Oracle Support Services.

If you require training or instruction in using Oracle software, then please contact your Oracle
local office and inquire about our Oracle University offerings. A list of Oracle offices is available
on our Web site at http://www.oracle.com.
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Preface

The Oracle Retail Process Orchestration and Monitoring User Guide describes the tracking
and managing of batch jobs.

Audience

This guide is for system administrators and operations personnel, integrators and
implementation staff personnel as well as users of the module.

Documentation Accessibility

For information about Oracle's commitment to accessibility, visit the Oracle Accessibility
Program website at http://www.oracle.com/pls/topic/lookup?ctx=acc&id=docacc

Access to Oracle Support

Oracle customers that have purchased support have access to electronic support through My
Oracle Support. For information, visit http://www.oracle.com/pls/topic/lookup?ctx=acc&id=info
or visit http://www.oracle.com/pls/topic/lookup?ctx=acc&id=trs if you are hearing impaired.

Customer Support

To contact Oracle Customer Support, access My Oracle Support at the following URL:

https://support.oracle.com

When contacting Customer Support, please provide the following:

• Product version and program/module name

• Functional and technical description of the problem (include business impact)

• Detailed step-by-step instructions to re-create

• Exact error message received

• Screen shots of each step you take

Oracle Help Center (docs.oracle.com)

Oracle Retail Product documentation is available on the following website https://
docs.oracle.com/en/industries/retail/html

Comments and Suggestions

Please give us feedback about Oracle Retail Help and Guides. You can send an e-mail to:
retail-doc_us@oracle.com

Oracle Retail Cloud Services and Business Agility

Oracle Retail (Product Name) Cloud Service is hosted in the Oracle Cloud with the security
features inherent to Oracle technology and a robust data center classification, providing
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significant uptime. The Oracle Cloud team is responsible for installing, monitoring, patching,
and upgrading retail software.

Included in the service is continuous technical support, access to software feature
enhancements, hardware upgrades, and disaster recovery. The Cloud Service model helps to
free customer IT resources from the need to perform these tasks, giving retailers greater
business agility to respond to changing technologies and to perform more value-added tasks
focused on business processes and innovation.

Oracle Retail Software Cloud Service is acquired exclusively through a subscription service
(SaaS) model. This shifts funding from a capital investment in software to an operational
expense. Subscription-based pricing for retail applications offers flexibility and cost
effectiveness.

Preface
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1
Common User Interface Controls

Oracle Retail applications, such as the Oracle Retail Process Orchestration and Monitoring
(POM) application, include some common interface options and controls that you can use
throughout the application workflow. The following sections describe these user interface
controls in more detail.

Although you may have more than one Oracle Retail application installed on your system, each
application may use many of the same interface components and abide by common rules and
constraints.

You can quickly access the tasks of current applications and switch to other applications from
the Navigation bar. For more information on the Navigation bar, see the Navigation Area
section.

The following topics are covered in this chapter:

• Logging on to the Application

• Navigation Area

• Table Menu Options

• Logging Out of the Application

Logging on to the Application
To log on to the application:

1. Go to the URL for the application in a web browser.

The Welcome Screen opens.
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Figure 1-1    Welcome Screen

2. Provide the following login information:

a. Enter your user name in the Username field.

b. Enter your password in the Password field.

3. Click Login.

Navigation Area
You can quickly access the tasks of current applications and switch to other applications from
the Navigation bar.

Figure 1-2    Navigation Bar

Chapter 1
Navigation Area
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The following Navigation bar options are common across all the applications:

• Favorites

• Tasks

• Notifications

• Reports

• Settings

Favorites
The Favorites option provides the ability to bookmark the templates that are used frequently
by a user. It provides quick and easy access to frequently used workflows. These bookmarks
save you navigation time through the task list and allow you to access commonly used
templates quickly. Favorites menu can be accessed using the star icon available on the left-
side menu bar.

Figure 1-3    Favorites Menu

Mark as Favorite
By clicking the star icon next to a task name, you can add a task to the Favorites list. A full star
next to a task name indicates that it is a Favorite. The icon is visible only when you hover over
the task. New favorites are always added to the end of the list, and they can be reordered in
the Edit Favorites page.

Chapter 1
Navigation Area
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Figure 1-4    Mark as Favorite

Unmark as Favorite
By clicking the star icon next to a task name, you can remove a task from the Favorites list. An
empty star next to a task name indicates that it is not a Favorite. The icon is visible only when
you hover over on the task.

Figure 1-5    Unmark as Favorite

Chapter 1
Navigation Area
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Pin Favorite
By clicking the pin icon in the Favorites menu, a favorite task can be pinned to the navigation
bar to easily access them. A full pin next to a task name indicates that it is pinned. To unpin a
task, click the pin icon again to display an empty pin icon. Pinned favorites can also be
managed from the Edit Favorites page.

Figure 1-6    Pin Favorite

Figure 1-7    Pinned Favorite in Navigation Bar

You can also unpin or remove a pinned favorite on the navigation bar by using the context
menu option, removing it from Favorites. The context menu option allows you to open the Edit
Favorites page.

Chapter 1
Navigation Area

User Guide
G38769-01
Copyright © 2025, Oracle and/or its affiliates.

July 23, 2025
Page 5 of 26



Figure 1-8    Unpin Favorite

Search Favorites
You can also search the bookmarked tasks in the Favorites menu by using the search option.
Start typing in the search input to find the matching favorite task and then select a favorite from
the search result to open that task.

Figure 1-9    Search Favorites

Chapter 1
Navigation Area
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Edit Favorite Window
You can organize, rename, pin and unpin Favorites in the Edit Favorites window. Click Edit
Favorites on the footer for the Favorites menu to open the Edit Favorites window.

Chapter 1
Navigation Area
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Figure 1-10    Edit Favorite

Chapter 1
Navigation Area
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Figure 1-11    Edit Favorites Window

Following actions can be performed from Edit Favorites window:

• Create Folder

• Edit a Favorite or Folder

• Delete Favorite or Folder

• Organize Favorites

• Toggle a Pin

• Pinned Navigation Bar Favorites

Tasks
Oracle Retail applications support a variety of navigational tools and methods that allow you to
move efficiently between application pages. Information on how to use and manage each of
the tools and methods is included in this section.

A task is a set of links to a series of task flows organized in a specific sequence to accomplish
a business process or procedure. For example, tasks can be defined for common multi-step
procedures or processes so that you can quickly step through tasks. By navigating sequentially
to the pages outlined in the task, you are assisted in stepping through the business process or
activity.

Your Tasks list appears on the top left side of the home page. All of the tasks to which you
have access are listed on the Tasks window. You can either click on the specific task name to
open or use the Task Search component to search for a Task that you want to open.

To begin working with a task, choose the application feature or process from the list.

Note

Your task menu may appear slightly different, depending on your retail application.

Chapter 1
Navigation Area
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Figure 1-12    Tasks Menu

Notifications
The Notifications option brings events within the application to your attention.

See the following examples:

Chapter 1
Navigation Area
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Figure 1-13    Notifications

Notification Badge
The Notification Badge displays the number of unread notifications for the user in the sidebar
menu. The Notification Badge displays '99+' when there are more than 99 notifications.

The notification count is periodically refreshed at regular intervals. This interval is determined
by a system-configured value.

Figure 1-14    Notification Badge

Chapter 1
Navigation Area
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Notification Sidebar
When you click the Notification icon, a Notifications Sidebar is shown that displays the most
recent set of unread notifications in the notifications screen (depending on the filter set).

Figure 1-15    Notifications Sidebar

When Toggle View is activated:

Chapter 1
Navigation Area
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Each component of the Notifications Sidebar is discussed in detail in the following sections.

Search Bar
A search bar at the top of the panel allows for searching through notifications. The search bar
has auto-suggest enabled, so it displays notifications as the user types.

Right next to the search bar is the 'List/Group' view toggle button. This causes the Notification
results to be displayed either in a flat or grouped view.

Chapter 1
Navigation Area
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Figure 1-16    Search Bar

Filtering Panel
The Filtering Panel allows you to filter notifications based on the creation Time Period, Type
and Severity.

The values for the Time Period and Severity components are pre-seeded constants. The Type
drop-down lists all the notification types available in the system.

When you click the Apply button, notifications that match the criteria are shown in the Results
Panel.

Chapter 1
Navigation Area
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Figure 1-17    Filtering Panel

Grouping Panel
This panel allows you to group notifications based on different attributes.

The values of the 'Group by' and the 'Then by' components are pre-seeded.

Chapter 1
Navigation Area
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Figure 1-18    Grouping Panel

Results Panel - List View
When no selection is made in the Grouping panel, the Results Panel displays notifications in a
list format.

The image below shows a simple search without any filtering or grouping.

Chapter 1
Navigation Area
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Figure 1-19    Results Panel - List View

Results Panel - Grouped View
Results Panel - Grouped View

Notifications are displayed in a grouped format within the Results panel, when the Group By
drop-down in the Grouping Panel is selected.

Notifications are displayed in groups with three notifications shown for each group.

Chapter 1
Navigation Area
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Figure 1-20    Results Panel - Grouped View

For each group, three notifications are shown followed by a 'See More' link. When you click
this link, up to 25 notifications are displayed for that group.

Results Panel - Summarized View
Notifications are summarized as shown in this example, when both the Group By and the Then
By dropdowns in the Grouping Panel are selected.

The summary view displays various groups and within them subgroups based on the
selections on the Grouping panel. For each subgroup, a count of the notifications within that
subgroup, grouped by severity is displayed.

The example here depicts a grouping by department, then by class.

Chapter 1
Navigation Area

User Guide
G38769-01
Copyright © 2025, Oracle and/or its affiliates.

July 23, 2025
Page 18 of 26



Figure 1-21    Results Panel - Summarized View

Notifications Tab
The Notifications tab opens when you click the 'See All' link at the bottom of the Notifications
side panel.

Chapter 1
Navigation Area
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Figure 1-22    Notifications Tab

This tab lists all the notifications for the logged-in user, regardless of whether they are in Read
or Unread status. Information tiles display a break-up of the total notifications by severity.
Clicking these tiles refreshes the table below to display only those notifications that are
relevant to that tile.

You can perform the following operations from this tab.

• Delete  - The table allows for multiple selection and hence multiple notifications can be
deleted at a time. Use the row header to select the row.

• Refresh  - This refreshes the list of notifications in the table.

• Mark as Read - Multiple Unread Notifications can be marked as Read by clicking this
button.

• Mark as Unread - Multiple Read Notifications can be marked as Unread by clicking this
button.

• Reassign Notifications  - Notifications can be reassigned to individual recipients or a
group by clicking the Reassign Notifications icon. On selecting a row in the All Notifications
table, and clicking the icon, the reassign notification popup is displayed. The Type is set to
Reassigned by default, and the Severity and Description are pre-populated from the
selected row; you can then change any of these values and assign the notification to one
or more recipients.

Chapter 1
Navigation Area

User Guide
G38769-01
Copyright © 2025, Oracle and/or its affiliates.

July 23, 2025
Page 20 of 26



Figure 1-23    Reassign Notification

The All Notifications table displays the following columns:

• Severity - A colored label indicating the Notification Severity.

• Status - If the status is unread, an icon  is shown. Otherwise, it is blank.

• Description - The description of the notification itself.

• Type- The description of the Notification Type for the notification.

• Alerts -

• Recipients - In case of individual notifications, this column contains the user ID of the user
to whom the notification is assigned. When the notification is assigned to multiple users, it
displays the text 'Multiple' and enables a context popup which lists all the recipients. This
field is empty when the notification is assigned to a group associated with a type.

• Creation Date - Timestamp showing the date and time of creation.

• Created By - User ID of the user who created the notification.

• Last Updated Date - Timestamp showing the date and time when the last update was
made.

• Last Updated By - User ID of the user who last updated the notification.

• Application ID - Unique identifier that identifies the application. Not visible by default.

• Department - The Department associated with the notification. Not visible by default.

• Class - The Class associated with the notification. Not visible by default.

• Subclass - The Subclass associated with the notification. Not visible by default.

• Location - The Location associated with the notification. Not visible by default.

• Supplier - The Supplier associated with the notification. Not visible by default.

• Performance - The Performance value associated with the notification. Not visible by
default.

Chapter 1
Navigation Area
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• Brand - The Brand associated with the notification. Not visible by default.

• Rollup Count - The Rollup Count associated with the notification. Not visible by default.

• Additional Information - Refers to the Additional Information attribute associated with the
notification. Not visible by default.

Reports
The functionality of Reports works similar to the Tasks menu.

Settings
The Settings icon on the Navigation Bar displays the application's Settings menu when clicked.
This menu differs per application and for POM, it contains the Application Properties menu
item.

Application Properties
Application properties are key-value pairs of parameters and configuration settings used by
POM to operate efficiently and to control the application's behavior. For instance, a property
may exist to turn off certain features within the application or to set limits on different event
timings. This screen is restricted to administrators as application inner-working expertise is
needed for understanding the impact of each property.

Application properties are grouped by Deploy Names, so one needs to be provided for the
search to return results.

Each property is provided with a default value in case a property value is not set. Each is also
provided with a Deployment Restart attribute, which indicates whether a server restart is
needed for a new value to take effect.

Chapter 1
Navigation Area
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The Application Properties page provides the following features:

• Search for application properties

• Filter application properties

• Sort application properties

• Update the value of an application property using the Edit Property dialog shown below:

Table Menu Options

Note

Figure 1-24, Figure 1-25 are representations and may be different for every window/
table/popup.

The Actions menu, View menu, and icons are displayed in the form of a table. For more
information on these options, see the sections Action Menu and Icons and View Menu.

Chapter 1
Table Menu Options
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Action Menu and Icons
The Actions menu provides the option to take different actions related to entries in the table.
Depending on the nature of the table, these actions can be add, view, delete or edit table rows,
create by moving to a new screen or export the table contents to the spreadsheet. Alternatively
these actions can also be performed by using the icon buttons on the table toolbar. For more
information on the icon/buttons, see the Screen Level Action - Icons and Buttons.

In some tables, it may also contain some table specific actions.

Figure 1-24    Action Menu and Icons

Table 1-1    Actions Menu/Icons and Descriptions

Actions Menu/Icon Description

Refresh and Refresh icon Select Actions > Refresh or the Refresh icon  to update the
records in the table.

Filter icon Select the Filter icon  to open fields that will filter the results.
Use the filter fields to only show the rows matching or containing
the entered information.

Detach and Detach Icon Select Actions > Detach or the Detach icon  to open the table in
a separate window.

View Menu
The View menu provides the options for managing the table columns and sorting and filtering
the table data.

In some tables you have the option to choose a saved custom view, which is an arrangement
of columns different from the default view of the table.

Chapter 1
Table Menu Options
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Figure 1-25    View Menu

Table 1-2    View Menu/Icons and Descriptions

View Menu List Description

Manage Columns You can show or hide columns and change the order of the
columns by selecting View > Manage Columns.
This View menu option is only available for tables with a large
number of columns.
Note that the changes performed on the Manage Columns popup
are persisted on the browser's cache and therefore are lost when
the cache is cleared or when the browser is changed. Persistence
of column preferences will be switched to the database in a future
release, thereby preserving those preferences even when browser
cache is cleared or when the browser is changed.

Detach and Detach icon You can view the tables in the application in a separate window
by selecting View > Detach or by using the Detach icon .

Query by Example You can filter the items by one or multiple column values by
selecting View > Query by Example.

Screen Level Action - Icons and Buttons
The screen level actions display the icons and buttons.

Table 1-3    Screen Level Action - Icons/Buttons and Description

Icons/Buttons Description

Close window Click the  icon to close the window.

Application Help and About Application Links
Use the Help list menu on the top right of the window, to open tabs for Application Help or
About Application.

Chapter 1
Application Help and About Application Links
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Figure 1-26    Application Help Menu

Logging Out of the Application
Use the User list menu on the top right of the window, to log out of the application.

Figure 1-27    Logging Out of the Application

Chapter 1
Logging Out of the Application
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2
Process Orchestration and Monitoring

The Process Orchestration and Monitoring (POM) application is a user interface for scheduling,
tracking and managing batch jobs. It’s also a facility for migrating data from one environment to
another.

Process Orchestration and Monitoring has the following tabs:

• Batch Monitoring

• System Configuration

• Batch Administration

• Scheduler Administration

• Schedule Maintenance

• AMS Utilities

• Data Migration

• Reports

Batch Monitoring
Batch Monitoring

The Batch Monitoring tab provides a runtime view of the statuses and dependencies with
regard to the different batch cycles for the selected business day.

Select Batch Monitoring in the Navigation Area to open the Batch Monitoring tab.

The application will by default open for a business date where at least one schedule is active. If
none found, it will open for the most recent business date where at least one schedule is
active.
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Figure 2-1    Batch Monitoring

Header
The header displays information about the batches displayed in the Batch Monitoring tab. You
can also use the header selection to choose which schedule batches to display.

Figure 2-2    Batch Monitoring Header

1. Business Date - Displays the business date for the oldest schedules displayed in Batch
Monitoring.

Use this field to select the oldest schedule displayed in Batch Monitoring.

2. Environments - Displays information about each environment integrated with Process
Orchestration and Monitoring.

Select one of these panels to display information about that environment’s batch
processes.

3. Monitoring Cycle - Displays the monitoring cycle of the batches displayed.

Select a monitoring cycle to see the batches scheduled for that cycle. The following
monitoring cycles are available:
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•  Nightly

•  Recurring

•  Standalone

4. Environment Status Icon - Click this icon to display a panel at the right side of the screen
showing the status of the Scheduler, Execution Engine and the environments. The user
can also manage the information displayed. See Status for more information.

5. Activity Feed - Click this icon to display a panel at the right side of the screen containing
activities performed by the system and by the user.

6. Close Schedule - Use this button to close the schedule. This button only appears for
Active schedules.

Note

Schedule will only close if the respective business date doesn’t have any Running/
Error job(s).

POM also provides the option to ignore this validation.

7. Restart Schedule - Use this button to restart the schedule. This button only appears for
Active schedules.

Note

Just like the Close Schedule, schedule will only restart if the respective business
date doesn’t have any Running/Error job(s).

POM also provides the option to ignore this validation.
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8. View Upgrades - Use this button to navigate to the Schedule Maintenance screen to view
more details on an upgrade when it is in progress or in error.

9. Download Cycle Summary - Use this button to download a summary for the currently
selected business day for the selected schedule. Once clicked, the Download Cycle
Summary dialog provides the user options to select the cycle and format. This button only
appears for Completed schedules.

10. Create Schedule - Use this button to create a new Scheduler Day. This button only
appears when a schedule tile is selected for which there is no open Scheduler Day. Click
this button to create a new Scheduler Day for the selected schedule for the business date
following the last schedule instance.
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11. Reopen Schedule - Use this button to reopen a closed schedule for the latest scheduler
day. This button only displays for an already completed schedule for the business day
shown. Reopening the schedule will clear the execution history for that day. A confirmation
message is displayed; for example: AIF APPS Schedule has already run and is complete
for 2023-06-22. Re-opening will clear the execution history for 2023-06-22 and load fresh
schedule instance. Would you like to proceed?

Schedule Tiles
Each schedule tile displays information for a batch schedule that POM is responsible for
running.

Select a tile to display the list of batch processes for that schedule.

Each panel displays the following information:

Figure 2-3    Schedule Tile

1. Schedule name and Version - Displays the abbreviation of the application or application
group and the software version. The display schedule name can alternatively be displayed
here instead of the default schedule name. The display schedule name can be configured
on the Schedule tab of the Batch Schedule spreadsheet.
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2. Run Status - Displays the status of the batch processes:

•  Completed (green check mark icon)

•  Active (green target icon)

•  Error (red X icon)

•  No activity (amber triangle icon)

•  Suspended (pause icon)

•  Safe mode (Amber circle icon with a warning icon inside of it)

•  Patch Mode (Amber circle icon with a warning icon inside of it)

3. Monitoring Cycles and Statuses - Displays the number of completed and total jobs for a
nightly / recurring cycle and the number of completed and total ad hoc flows / processes
for a standalone cycle.

4. Last Schedule Date - Indicates the last date on which the batch processes were
configured.
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Note

• A green tile with a green target icon in the top left indicates that the schedule is in
progress.

• A green tile with a green checkmark icon in the top left indicates that the schedule
has completed.

• A red tile with a red cloud icon indicates that a new schedule version upgrade has
failed. Navigate to the Schedule Maintenance screen by clicking on the View
Upgrades button to address the failure.

• A blue spinner icon in the top left of the tile (2) indicates that the schedule is in the
process of being upgraded to a new version. The user can navigate to the 
Schedule Maintenance screen by clicking on the View Upgrades button to check
the progress of the upgrade.

When a schedule is being upgraded or when the schedule upgrade has failed, the
user is prevented from most activities on the Batch Monitoring and on the Batch
Administration screen.

• An amber warning circle icon in the top left of the tile (2) indicates that the
schedule is set to run in safe mode. This means that the batch schedule will
simulate a complete run but without the jobs actually executing on the application
server. Aside from the amber warning circle icon displayed in the top left of the tile,
an amber ‘Safe Mode’ message is displayed in the area right below the tile area.

• An amber warning circle icon in the top left of the tile also indicates that patching is
currently in progress and run executions will be paused until the patching
completes. Aside from the amber warning circle icon displayed in the top left of the
tile, an amber ‘Patch Mode’ message is displayed in the area right below the tile
area.

• An amber tile indicates that there is no instance of the schedule for the selected
business date.
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Batch Jobs Header
The batch jobs header displays the following information:

Figure 2-4    Batch Jobs Header

Run Status Chart
The run status chart shows a chart summary of the status of the different batches (including
the number of batch jobs with that status) that are included in the selected cycle for the
selected schedule. The possible statuses are:

• Loaded - Jobs are in loaded state when the scheduler day is first created.

• Pending - Job is waiting to run.

• Completed - Job ran successfully on the system.

• Error - A failure occurred due to an issue in the environment or the job's application.

• Held - An administrator placed the job on hold.

• Skipped - An administrator has skipped the running of the job so the remaining jobs in the
cycle can proceed.

• Running - Job is currently running on the system.

• Long Running - The job's run time has exceeded a threshold. If a Threshold Run Time is
specified for the job on the Edit Job popup of the Batch Administration screen, then a job is
deemed long running if its current run time exceeds that value. Otherwise, if a Threshold
Run Time is not specified, then the job is deemed long running when its current run time
exceeds the Long Run Average Time Multiplier (specified on the Edit Settings popup of the
System Configuration screen) times the average run time of that job + Long Running
Tolerance Level. The value for the Long Running Tolerance Level can be overridden by
changing the value of batch schedule variable defaultLongRunningToleranceLevel on
the System Options screen accessed from the System Configuration screen. The value is
in seconds.

For example, if a job's average run time is 3 minutes, and the Long Run Average Time
Multiplier is 3, and the Long Running Tolerance Level is 6 minutes, then the job is
considered long running if it has been running for at least 15 minutes. A notification is sent
when a job is deemed long running.

If the Threshold Run Time field for a job is 0 or blank, and there is no history of job run,
the job will be considered long-running when its run time exceeds the default long running
threshold run time of 10 minutes. This default value can be overridden by changing the
value of batch schedule variable defaultLongRunningThresholdRunTime on the System
Options screen accessed from the System Configuration screen. The value is in seconds.

• Disabled - Job was disabled by an administrator on the Batch Administration screen.

• System Held - Job was placed on hold by the system due to a lack of resources to run it.
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• Skipped on Error - Job was preconfigured to be skipped on a failure.

• Waiting - Job is waiting for completion of pre-dependencies (Hourly Cycle, Nightly Cycle,
External Dependency and Inter-Schedule Predecessor Jobs).

Completed Batch Job Statistics

Note

Completed Batch Job Statistics are displayed only for Nightly and Recurring cycles.

For completed batch jobs, the batch job header shows the following information:

• Run Start

• Run End

• Total Duration

• Average Duration

Active Batch Job Statistics

For active batch jobs, the batch job header shows the following information:

• Run Start

• Expected Completion - Only Nightly jobs are considered in the calculation of the Expected
Completion time. Dependencies, such as external dependencies, inter-schedule
dependencies, and custom dependencies of Nightly jobs on Adhoc Flows are not
considered in the calculation and may impact Expected Completion time.

• Remaining Duration

• Average Duration

Batch Information
The batch information area displays the following information about the batch process results:
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Execution Requests - Displays the number of completed executions and the total number of
execution requests. Click to open the Execution Requests Window.

Agent Job Requests - Displays the number of completed and total number of Agent job
requests. Click to open the Agent Job Requests Window for the schedule and cycle selected.

Scheduler Tasks - Displays all tasks scheduled to run during the current scheduler day. Click
to open the Scheduler Tasks window.

External Dependencies - Displays the number of successful and total number of external
dependencies. Click to open the Batch Cycle Details Screen.

Inter-Schedule Dependencies - Displays the number of successful and total number of inter-
schedule dependencies. Click to open the Batch Cycle Details Screen.

Callbacks - Displays the number of successful and total number of callbacks. Click to open the 
Batch Cycle Details Screen.

Schedule Links - Displays the number of successful and total number of schedule links. Click
to open the Batch Cycle Details Screen.

Execution Requests Window
The Execution Requests window displays information about execution requests for a batch.

Click Done or the close window icon  to close the window.

Figure 2-5    Execution Requests Window

Execution Requests
This section displays the following information about each execution request in the batch
process:

• Execution ID

• Status
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• Request Type

• Cycle

• Flow

• Scheduler Day

• Total Jobs

• Completed

• Pending

• Skipped

• Failed

• System Held

• Submitting

• Submitted

See Table Menu Options in the Common User Interface Controls for information about the
options available for this section.

Execution Details
This section displays the following information about each job run by the execution request:

• Job Run ID

• Status

• Job Name

• Process Name

• Log – Download log in text file format.

• Job Execution ID

• Last Update

• First Job

• Error Info

See Table Menu Options in the Common User Interface Controls for information about the
options available in this section.

Agent Job Requests Window
The Agent Job Requests window displays information about batch requests submitted to the
POM Agent. The agent is the component of POM usually deployed on the application server
where the batch jobs actually execute.

Click Done or the close window icon ( ) to close the window.
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Figure 2-6    Agent Job Requests Window

Agent Job Requests
This section displays the following information about each Agent job request in the batch
process:

• Status - Possible values are Complete, Running, Error, and Loaded

• Request ID - Agent request ID

• Type - Possible values are EXEC (shell script based job) or RI/RASE/RDS/
RPAS/BDI/OB/OMS which are all values for service based jobs

• Job - job name

• Process - Process name

• Payload - Service payload in case the type corresponds to a service based job

• Info - Error Information in case the request is in Error status

• Agent Id - The identifier of the Agent which Initiates the job execution request

• Application Name

• Create Date

• Start Time

• End Time

• Last Update Time

• Execution Request Id

• Job Run Id

See Table Menu Options in the Common User Interface Controls for information about the
options available in this section.
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Scheduler Tasks
The Scheduler Tasks window displays information about tasks that are scheduled to run during
the current scheduler day. See the Scheduler Administration section of this chapter.

When the new scheduler day is created every day (at the end of the Nightly batch run), it
creates the scheduler tasks according to the way they are set up in the Scheduler
Administration screen.

Figure 2-7    Nightly Scheduler Task Window

Figure 2-8    Recurring Scheduler Tasks Window

Click Done or the close window icon ( ) to close the window.
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The Scheduler Tasks window for the Nightly and Recurring cycles display the same task
attributes listed below. The difference is that there is only one Nightly task for a scheduler day
whereas there could be multiple Recurring flows running throughout the day.

Nightly/Recurring Scheduler Tasks
This section displays the following information about each Nightly/Recurring Scheduler task:

• Task ID

• Enabled - Switch to enable or disable the execution of the task

• Status - Possible values are: Enabled, Disabled, Completed, Skipped On Delay,
Scheduled, Error, or Cancelled

• Flow Name - Nightly or recurring flow name

• Schedule Date

• Schedule Time

• Time Zone

Note

When the New Scheduler Day is created, if the start time for a certain task has
elapsed, the task will be scheduled for the next day. The Next Schedule Run column
will show the next time the task will execute.

See Table Menu Options in Common User Interface Controls for information about the options
available for this section.

Task Executions
This section displays the following information about each task executions:

• Status - Possible values are: Completed, Error

• Start Time

• Info - If the Status is Error, this field changes to a link which, when clicked, will open a
dialog showing error details.

See Table Menu Options in Common User Interface Controls for information about the options
available in this section.

The user can edit the Nightly or Recurring tasks to change the time they run for the day.
Permanent changes need to be entered in the Scheduler Administration screen.

Note

If the user makes a change to the time, he or she needs to click the Run action to
schedule the task.

It is alternatively possible for the user to circumvent the steps mentioned above and
click on Run Now if they intend to schedule the task for immediate execution.
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When Run or Run Now is clicked, confirmation windows are displayed based on the time zone
and current business date.

Figure 2-9    The scheduled time in the given time zone is past the current date

Figure 2-10    The scheduled time in the given time zone has not passed the current date

Also, for the task to be editable, it must be in a state other than Scheduled. If it is in a
Scheduled state, the user can click the stop action, which puts the task in a Cancelled state,
and it will then be editable.
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Standalone Scheduler Tasks

Figure 2-11    Standalone Scheduler Tasks Window

Click Done or the close window icon ( ) to close the window.

Standalone Scheduler Tasks
This section displays the following information about each Standalone Scheduler task:

Task ID

Enabled – Switch to enable or disable the execution of the task.

Status – Possible values are: Enabled, Disabled, Completed, Skipped On Delay, Scheduled,
Error, Cancelled.

Name – Indicates Process / Flow name

Type – Indicates whether it is Process or Flow
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Description – Provides a description of the task

Frequency – Single or Every x minutes.

Limit Occurrences –If this field has a value, the process will run every x minutes for y
occurrences.

Prevent Start During Nightly – Indicates that the process should not start running when
Nightly is in progress. If the process starts running before Nightly start, it will continue running
even if the run extends into the Nightly run.

Schedule Date

Schedule Time

Next Run In – Displays the time remaining until the next run.

Time Zone

Click Done or the close window icon ( ) to close the window.

See Table Menu Options in Common User Interface Controls for information about the options
available in this section.

The user can edit a Standalone task to change any of the fields in the window below. Edits are
effective just for the day's run. Permanent changes must be entered in the Scheduler
Administration screen.
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Note

If the time is left blank for a standalone task, it will execute immediately upon clicking
Ok.

When the New Scheduler Day is created, if the start time for a certain task has
elapsed, the task will be scheduled for the next day. The Next Schedule Run column
will show the next time the task will execute.

Task Executions
This section displays the following information about each task execution:

• Execution ID

• Status - Possible values are: Completed, Error

• Start Time

• Info - If the Status is Error, this field changes to a link which, when clicked, will open a
dialog showing the error details.

See Table Menu Options in Common User Interface Controls for information about the options
available in this section.
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Batch Cycle Details Screen

The Batch Cycle Details screen displays the following sections:

Header
The header displays the following information about the batch cycle:

• Run Status Chart

Completed Batch Job Statistics
Completed Batch Job Statistics

For completed batch jobs, the batch job header shows the following information:

• Run Start

• Run End

• Total Duration

• Average Duration

Active Batch Job Statistics
For active batch jobs, the batch job header shows the following information:

Note

Active Batch Job Statistics are not yet implemented. They will be implemented in a
future version of POM.

• Run Start

• Expected Completion
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• Remaining Duration

• Average Duration

External Dependencies

The External Dependencies section lists all the external batch job dependencies for the entire
current Schedule. These dependencies are only shown if the system level external
dependencies indicator is turned on. An external dependency is usually a dependency on a
customer's internal process. This dependency is released once the customer calls an endpoint
into POM for a specific POM job.

The following information is displayed for each external dependency:

• Status

• Source Job - Click to open the job in the Batch Job Details screen. The source job is a job
in the current schedule which is dependent on the external (target) job.

• Target Job - The job that, when complete, will release the dependency which the source
job is waiting on.

Inter-Schedule Dependencies

The Inter-Schedule Dependencies section lists all the inter-schedule batch job dependencies
for the entire current Schedule. These dependencies are only show if the system level inter-
schedule dependencies indicator is turned on. An inter-schedule dependency links the current
schedule and a target schedule where a job in the target schedule is dependent on the
completion of a job in the current schedule.

The following information is displayed for each inter-schedule dependency:

• Status

• Source Job - Click to open the job in the Batch Job Details screen.

• Target Job - Click to open the job in the Batch Job Details screen. Target job is dependent
on the source job.

• Target Process - Process containing the target job.

• Target Schedule - Schedule containing the target process/job.

• A Disable/Enable button to disable or enable the dependency.
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Custom Dependencies

A Custom Dependency includes entities (processes/flows) that execute prior to the current job
in Nightly or Recurring cycles where the dependency is placed. Once the dependency
completes successfully, the nightly or recurring job is triggered.

Note

Custom Dependency is not applicable for Standalone/Adhoc jobs.

The following information is displayed for each custom dependency link:

• Status – Pending or Complete

• Target Flows/Process – List of Adhoc Flows or Processes based on the Target Entity
selection.

• Sequence - The sequence of execution of the target flow/process.

Schedule Links

A Schedule Link links the current schedule and a target schedule where the current schedule
does not start until the completion of a job in the target schedule.

The following information is displayed for each schedule link:

• Status

• Source Job - Click to open the job in the Batch Job Details screen. The job in the current
schedule which starts the current batch when the Target Job completes.

• Target Job - Click to open the job in the Batch Job Details screen. The job in the Target
Schedule which when completes fulfills the dependency for the Source Job in the current
schedule.

• Target Process - The process which the Target job belongs to. - The schedule whose job is
a dependency for the job in the current schedule.

• Info - Shows information regarding error if failed or skipped.
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• Target Schedule

• If it was not successful, a Retry button to retry the schedule link.

Callbacks

The Callbacks section lists all the external status update request and response callbacks
based on the External Status Update mode set in the External System Configuration screen.

The following information is displayed for each callback:

• Status

• Job - Click to open the job in the Batch Job Details screen.

• Process - Process containing the job.

• Date of callback

• A Payload link to display the Callback - Payload Window for the callback.

• An Info link to display the Callback - Info Window describing the callback response.

• If the callback was not successful, a Retry button to retry the callback.

Nightly and Recurring Batch Jobs

The Batch Jobs section lists all the batch jobs for the selected schedule and the selected cycle
– Nightly or Recurring. The table displays the following information:

• Status

– Loaded - Jobs are in loaded state when the scheduler day is first created.

– Pending - Job is waiting to run.

– Completed - Job ran successfully on the system.

– Error - A failure occurred due to an issue in the environment or the job's application.
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– Held - An administrator placed the job on hold.

– Skipped - An administrator has skipped the running of the job so the remaining jobs in
the cycle can proceed.

– Running - Job is currently running on the system.

– Long Running - The job's run time has exceeded a threshold. If a Threshold Run Time
is specified for the job on the Edit Job popup of the Batch Administration screen, then
a job is deemed long running if its current run time exceeds that value. Otherwise, if a
Threshold Run Time is not specified, then the job is deemed long running when its
current run time exceeds the Long Run Average Time Multiplier (specified on the Edit
Settings popup of the System Configuration screen) times the average run time of that
job + Long Running Tolerance Level. The value for the Long Running Tolerance Level
can be overridden by changing the value of batch schedule variable
defaultLongRunningToleranceLevel on the System Options screen accessed from
the System Configuration screen. The value is in seconds.

For example, if a job's average run time is 3 minutes, and the Long Run Average Time
Multiplier is 3, and the Long Running Tolerance Level is 6 minutes, then the job is
considered long running if it has been running for at least 15 minutes. A notification is
sent when a job is deemed long running.

If the Threshold Run Time field for a job is 0 or blank, and there is no history of job
run, the job will be considered long-running when its run time exceeds the default long
running threshold run time of 10 minutes. This default value can be overridden by
changing the value of batch schedule variable
defaultLongRunningThresholdRunTime on the System Options screen accessed
from the System Configuration screen. The value is in seconds.

– Disabled - Job was disabled by an administrator on the Batch Administration screen.

– System Held - Job was placed on hold by the system due to a lack of resources to run
it.

– Skipped on Error - Job was preconfigured to be skipped on a failure.

– Waiting - Job is waiting for completion of pre-dependencies (Hourly Cycle, Nightly
Cycle, External Dependency and Inter-Schedule Predecessor Jobs).

• Job - Click to open the job in the Batch Job Details screen.

• Application

• Last Update

• Parameter

• Job Type - Depending on the value, determines if a job is service based or shell script
based.

• Process Name

• Process Status

• Log - When the job is in error, this field will display a down-arrow icon which when clicked
will display the content of the log. There’s also a ‘View Live Log’ icon which when clicked
will show the streaming log.

• Job Description

• Start Time

• End Time

• Duration
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• Average Run Time

• Average Historical Run Time

• Number of Runs

• Error Source

• Waiting

• Waiting Reasons

View Live Log
The View Live Log window displays the live log of the running jobs.

The following options are seen in the window.

• Enable Auto-scroll – When this switch is turned on, the log auto scrolls to view the next
page.

• Go to Top – Scroll to the top of the page.

• Go to Bottom – Scroll to the bottom of the page.

• Download Log – Downloads and displays the content of the log.

• Auto Refresh (Footer) – Live log refresh interval.

Action Menu and Icons
See Action Menu and Icons for common actions that can be performed through the Action
menu and the icons. You can also perform the following actions:
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Table 2-1    Batch Jobs - Actions Menu/Icons and Description

Actions Menu/Icons Description

Show Disabled Use the Actions > Show Disabled or Show Disabled. By Default,
the table won’t show any jobs with Disabled Status. Use Show
Disabled button or action to see the list of Disabled job.

Hold Use the Actions > Hold or the Hold button to put the process on
hold.

Skip Use the Actions > Skip or the Skip button to skip the process.

Run Use Actions > Run or the Run button to run the job manually and
immediately.
Run is disabled for both Nightly and Recurring Cycles but jobs
from both of the cycles can be run from AMS Utilities > Manual
Job Run menu.

Rerun Use the Actions > Rerun or the Rerun button to run the job again.

Kill Use the Action>kill or the Kill button to stop the execution of the
job.
The job needs to be running for this action to be enabled. When
the Kill command is enacted on the screen one of two
confirmation messages opens depending on whether a cleanup
script is associated with the job being killed.
If a cleanup script is associated with the job, the confirmation
message presented is “a cleanup will be performed after this job
is terminated. It is advisable to wait a few minutes after
termination before proceeding with the remaining batch
schedule” This is because it may take a minute or so for the
cleanup to complete.
If a cleanup script is not associated with the job, the user is
cautioned to make sure he or she is sure about proceeding
without a cleanup script.
That maybe be acceptable, as not all jobs require cleanup when
terminated. The confirmation message in this case is “there is no
post termination cleanup script associated with this job. the job
will be terminated but not post cleanup will be performed. This
may or may not be ok for this job. Check with Oracle Support if
this is a concern.

Edit Parameters Use the Actions > Edit Parameters or the Edit Parameters
button to edit the parameters for the job. The new parameters are
only effective for the current day's batch run.

View Menu
See View Menu for information about the options in the View menu.

Skip Recurring Flow(s)
A job in a recurring flow can be skipped by selecting the job and clicking the Skip button in the
table toolbar. The confirmation pop up (below) opens asking the user if the job should to be
skipped for the currently selected recurring cycle or for this and all subsequent recurring cycles
as well.
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Refer Skip Recurring Flow(s) under “AMS Utilities” to skip an entire flow in one or more hourly
cycle(s).

Status Details for Job
Certain status values on the Batch Jobs section such as 'Error' or 'Long Running' act as a link.
When clicked a popup is displayed containing more details about why the job is in the given
status and helpful suggestions for resolving the issue. An example is shown below for a job in
error.
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Rerun Multiple Jobs
Multiple failed jobs can be selected on the Batch Monitoring table and restarted by clicking the
Rerun Failed Job(s) button from the table toolbar.

Multi-Select Jobs
Multiple jobs can be selected on the Batch Monitoring table and all actions like Run, Rerun,
Hold, Skip, Kill, and so on can be performed on the selected jobs. The pop-up window below
opens for every action performed, asking the user to enter a comment before performing the
action.

Standalone Batch Jobs
The standalone cycle includes the following information for each flow, process and job:
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Figure 2-12    Standalone Batch Sections

Left Pane of the Screen
• Search by Name or Status - Search for an invokable by entering a search term and

clicking Enter. An invokable can be a flow or a process that does not belong to a flow.

• Show Disabled - When this switch is enabled, disabled processes and flows are also
listed on the left panel.

• Flows/Processes - The following information is shown for each flow/process:

– Flow/Process Name

– Status

* Loaded - A flow or process is in a Loaded state when the scheduler day is first
created.

* Completed - A flow or process that ran successfully on the system.

* Error - A failure of a flow or process occurred due to an issue in the environment
or the job's application.

* Cancelled - A flow or process in a Loaded status is marked as Cancelled when
the scheduler day is closed.

– Flow/Process Label

–
Run Icon - Click on the play button to run the adhoc flow/process. It is available only
when the status of the flow/process is in a Loaded or Completed status.

Right Pane of the Screen
Click a row in the left panel of the Standalone Entities table to refresh the Batch Jobs table, list
the jobs for the selected standalone flow/process, and display information similar to what is
listed in the Nightly and Recurring Batch Jobs section above.
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Action Menu and Icons
See Table Menu Options in Common User Interface Controls for information about the options
available in this section. You can also perform the following actions:

Actions Menu/Icons Description

Show Disabled Use the Actions > Show Disabled or Show Disabled. By Default,
the table won’t show any jobs with Disabled Status. Use Show
Disabled button or action to see the list of Disabled jobs.

Run Use the Actions > Run or the Run button to immediately run the
individual job of the process or flow.

Skip Use the Actions > Skip or the Skip button to skip the batch job
immediately. Based on the status of the job (Loaded or Error), a
warning pop up opens if the job needs to be skipped for the
current failed execution or for the immediate next execution or
for all job executions on the current business date.

Figure 2-13    Skip Warning – Job is in ‘Loaded’ or ‘Completed’ status
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Figure 2-14    Skip Warning – Job is in ‘Error’ status

Standalone Execution Details

Figure 2-15    Standalone Executions
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Clicking on a flow/process link from the left panel of the Standalone Entities table opens a new
modal window displaying the Batch Execution details. The following information is displayed
about each execution.

• Status

– Loaded – Jobs are in loaded state when the scheduler day is first created.

– Completed – Job ran successfully on the system.

– Error – A failure occurred due to an issue in the environment or the job’s application.

– Cancelled – Flow which are in Loaded status, are marked cancelled when the
scheduler day is closed.

• Execution ID

• Process Exec ID

• Start Time

• End Time

Figure 2-16    Standalone Execution Detail

The following information about the jobs executed for each Execution ID is displayed when an
Execution row is selected.

• Status

– Loaded - Jobs are in loaded state when the scheduler day is first created.

– Disabled - Job is in disabled state.

– Completed - Job ran successfully on the system.

– Skipped - Job is in skipped.

– Skipped_On_Error - Job is in skipped when it throws an error

– Error - A failure occurred due to an issue in the environment or the job's application.

– Held – Job is in held state.

• Job – Name of the job
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• Process – Name of the process

• Job Exec ID

• Job Run ID

• Start Time

• End Time

Clicking on the job link (for example, VARIABLE_REFRESH_JOB) from the Execution Details table
opens the Batch Job details in a new modal window and provides detailed information about a
batch job

Batch Job Details
The Batch Job Details screen provides detailed information about a batch job.

Depending upon the status of the job, one or more of the following buttons will be available at
the top of the screen:

• Hold

• Run - This is available only for Standalone jobs.

• Release

• Release Skip

• Rerun

• Skip

Figure 2-17    Batch Job Details
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Figure 2-18    Batch Job Details – Continued

Figure 2-19    Batch Job Details with Status Information

Execution Requests
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If the job was executed, this section displays the following information about the job execution:

• Status

• Execution ID

• Request Time

• Log - Provides a link to download the execution log

• Error Info - This will only show in case of an error status

Executions

If the job was executed, this section displays the following information about the job execution:

• Status

• ID

• Job Run ID

• Start Time

• End Time

• Log -Provides a link to download the detailed execution log. This log, unlike the Job Log,
contains more information related to POM application activities rather than just Job
execution activities.

• Job Log -Provides a link to download the job execution log.

Pre Dependencies

This section displays the following information about job pre-dependencies:

• Status
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• Job - Click to open the job in the Batch Job Details screen.

• Process

• A Disable/Enable button is available for jobs that have not yet completed.

Post Dependencies

This section displays the following information about job post-dependencies:

• Status

• Job - Click to open the job in the Batch Job Details screen.

• Process

• A Disable/Enable button is available for jobs that have not yet completed.

External Dependencies

An external dependency is usually a dependency on a customer's internal process. This
dependency is released once the customer calls an endpoint into POM for a specific POM job.
This section displays the following information about job external dependencies:

• Status

• Job - Click to open the job in the Batch Job Details screen. The job that, when complete,
will release the dependency which the currently displayed job is waiting on.

• A Disable/Enable button is available for jobs that have not yet completed.

Inter-Schedule Dependencies
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An inter-schedule dependency links the current schedule and a target schedule where a job in
the target schedule is dependent on the completion of the currently displayed job in the current
schedule. This section displays the following information about job inter-schedule
dependencies:

• Status

• Job - Click to open the job in the Batch Job Details screen. Job which is dependent on the
source job.

• Process - Process containing the job.

• Schedule - Schedule containing the process/job.

• A Disable/Enable button is available for jobs that have not yet completed.

Schedule Links

This section displays the following information about schedule links for a job:

• Status

• Job - Click to open the job in the Batch Job Details screen. The job in the Target Schedule
that., when completed, will fulfill the dependency for the currently displayed schedule.

• Process - The process the job belongs to.

• Schedule - The schedule whose job is a dependency for the job in the current schedule.

• Info - Shows information regarding error if failed or skipped.

• A Disable/Enable button is available for jobs that have not yet completed.

• A Retry button is available for schedule links with a Skipped or Failed status.

Callbacks

This section displays the external status update request and response callbacks based on the
External Status Update mode set in the External System Configuration screen. This section
displays the following information about job callbacks:

• Status

• Job - Click to open the job in the Batch Job Details screen.

• Process

• A Payload link to display the Callback - Payload Window for the callback.
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• An Info link to display the Callback - Info Window describing the callback response.

• A Retry button is available for callbacks with a Skipped or Failed status.

Callback - Payload Window
The callback payload window shows the field name and value for each field in the payload.

Select Done to close the window.

Figure 2-20    Callback Payload Window

Callback - Info Window
The callback info window shows information about a request and response.

Select Done to close the window.

Figure 2-21    Callback Info Window
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Footer

The screen can be set to auto refresh periodically by selecting the pre-defined interval from the
Auto Refresh list. By default, this value is set to None on page load.

Use the Refresh button to refresh the screen immediately.

Use the Rerun Failed Job(s) button to open a pop-up list of all failed jobs in the cycle
regardless of the reason for failure. The user can then select the jobs they want bulk-restarted.

Last refreshed shows the time and date of the last refresh of the interface.

Status
Status

The Status sidebar displays information about the Scheduler, Execution Engine, and the
environments that Process Orchestration and Monitoring communicates with to execute
batches.
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Figure 2-22    Status Sidebar

Scheduler
Displays the status of the Scheduler, and an Admin link to enable or disable the scheduler for
a particular batch schedule in the Scheduler Administration window.

Execution Engine
Displays the status of the execution engine, and a Config show configuration of the execution
engine in Execution Engine Configuration.

Environment Statuses
Displays the following for each environment:
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Figure 2-23    Environment Status

1. Status - Icon indicating the current status of the integration with the environment. This will

be either success  or error .

2. Schedule - Display Name of the Schedule

3. Health Check - Opens the Health Check for the schedule.

4. Active/Suspended Switch - Toggle button to suspend or activate the schedule.
Suspending the schedule prevents new job run requests from being processed by POM.
Jobs that are already running will keep running and won’t be terminated. Activating the
schedule causes POM to resume processing all job requests for the schedule.

5. Link - An icon which indicates if Inter-Schedule Dependencies are enabled or disabled.

Download Cycle Summary
Use the Download Cycle Summary window to download information about a completed batch
cycle:

1. Click Download Cycle Summary in the Batch Jobs Header.

The Batch Cycle Summary window opens.

Figure 2-24    Download Cycle Summary Window
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2. Use the Cycle menu to select the cycle for which to download the summary.

3. Select the Type of data to download: CSV (comma-separated values) or JSON.

4. Click Download to download the summary file, or click Cancel to close the window without
downloading.

5. Click Open Report to open the Batch Jobs Timeline window.

Scheduler Administration Window
The Scheduler Administration window allows you to enable or disable batch schedules.

When the Scheduler is disabled for a particular schedule, tasks will still be scheduled and will
still trigger at the specified time but will immediately move to the Cancelled state.

Select the Done button to close the window.

Figure 2-25    Scheduler Administration Window

Execution Engine Configuration
The Execution Engine Configuration window displays configuration of communication between
the user interface and the execution engine.

Select the Done button to close the window.

This window displays the following configurations:
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Figure 2-26    Execution Engine Configuration Window

• Executor Service Polling Interval - Determines the number of seconds between each
polling interval for the batch execution process on Process Orchestration and Monitoring.

• Monitoring Service Polling Interval - Determines the number of seconds between each
polling interval for the monitoring process on Process Orchestration and Monitoring.

• Thread Pool Size - Maximum number of concurrent threads permitted for use by the
Execution Engine.

Health Check
The Health Check window displays the status of the processes communicating with the
environment.
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Figure 2-27    Health Check Window

This window displays the following for each communication process:

• Severity - The severity of any errors in communication:

–  SUCCESS - The process communicates successfully.

–  ERROR - The process is not communicating with the environment.

–  – WARNING – POM Agent is not configured / not mapped to any application.

• Source

– The name of the process

– The response received by the process

– POMAgent URL

– Auth Mode and S3 path (if applicable)

Activity Feed
The Batch Monitoring screen includes an Activity Feed icon at the top right corner.
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When the icon is clicked, the Activity Feed panel opens on the right side of the screen. The
panel displays up to seven days’ worth of activities performed both by the system and by users
through the user interface.

Click the close window icon ( ) to close the window.
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Figure 2-28    Activity Feed
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System Configuration
The System Configuration screen allows an administrator to modify parameters and
connection properties for the environments integrated with Process Orchestration and
Monitoring. It also allows an administrator to maintain POM application-level configurations.

Select System Configuration in the Navigation Area to open the System Configuration screen
and select the Schedules tab. This tab displays the schedule level configurations for each
schedule setup for this environment.

Figure 2-29    System Configuration

Configure New Schedule
When POM is first installed for a specific customer, it does not include any application batch
schedules out of the box such as Merchandising, Retail Intelligence, and so on. An Oracle
administrator or a system integrator needs to first configure those schedules before they can
be loaded (from a batch schedule spreadsheet). Configuring a new schedule entails setting up
schedule properties such as the schedule name and description, customer environment
information for callbacks. It also entails setting up the location of different components and
services with which different POM components need to interact to function properly.

Configuring a new schedule is typically done upon provisioning the environment by Oracle
operations. If for any reason the configuration has not yet been done by Oracle, an
administrator can alternatively accomplish that through the UI.

To configure a new schedule, click the Configure New Schedule button at the top right of the
Schedules tab of the System Configuration screen. The Configure New Schedule window is
displayed.
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Figure 2-30    Configure New Schedule

The following new schedule information can be set on this window:

• Schedule Configuration - This is for identifying and describing the schedule. Attributes for
this section are:

– Schedule Name (Mandatory) - A short identifier of the new schedule. This usually
matches the main application name such as Merchandising, RI, and so on. The
Schedule Name must be 10 characters or less

– Description (Mandatory) - A short description of the schedule.

• External System Configuration (Optional) - This identifies an external system, typically a
customer's environment. This is needed for optionally notifying the customer's system of a
job failure or success. This feature is also referred to as Callback. Attributes for this section
are:

– URL

– Username

– Password

• Platform Services (Optional) - Internal Oracle services for retrieving information stored
there by other applications or systems. Attribute for this section is:

– URL

• Job Agent (Mandatory) - The Job Agent is a component of POM responsible for
submitting the request to execute a batch job. This is usually deployed in the same location
as the application where the jobs actually run. The same agent can be used for multiple
schedules. If the schedule being configured contains multiple applications, it is optional to
add an agent for each application. This isn't a common practice however as an agent can
handle running multiple applications. Attribute for this section is:

– URL
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Note

For custom schedules, the Agent URL must be set to http://pomagentservice:8080/
POMAgent. This will enable POM to use its internal/ common Agent to run jobs.

• Schedule Variables (Optional) - These variables hold System (POM) level configurations
such as IDCS or OCI IAM URL, or Job level configurations such as batch directory,
DB_ALIAS, and so on. The job level configurations can also be defined on the batch
schedule spreadsheet. Attributes for this section are:

– Type - Job or System

– Variable Name

– Value

• Services (Optional) - This section allows for entry of services POM integrates with. These
include the BDI Process Services, IDCS or OCI IAM, and all services corresponding to the
different applications with service-type batch jobs. Attributes for this section are:

– Type - This is a drop down for all the possible service types; for example, the RI Web
Services URL which POM would use to invoke RI service-based batch jobs.

– Application - Application Name to which this service corresponds such as RI.

– URL

• Job Type (Optional) - This is an optional section for setting up one or more custom job
types other than the standard, pre-defined job types provided by the retail applications,
such as EXEC, RI, RASE, BDI, RDS, OB, OMS, and RPAS. The user then associates a
custom job type with the base URL for endpoints at the destination system. These are
endpoints for starting a job, restarting a job, killing a job, checking status of a job, fetching
the log for a job, and validating the URL. By setting up a custom job type, the user must
then create a custom schedule spreadsheet containing jobs with that job type. When this
batch schedule runs, POM executes that job using the corresponding, defined Start
endpoint. If the user misses the opportunity to configure the job type at this point, they do
have the opportunity to add that using the Job Type Configuration screen (see Create /
Edit Job Type for more information). Attributes for this section are:

– Name – A short, alphanumeric identifier of the job type. This typically reflects the
system or application where associated jobs are to be executed (for example, RDS).

– URL – Base URL for endpoints at the destination system where batch is to be invoked
(for example, https://server/services/batch).

– OAuth Scope – Authentication scope for accessing the batch endpoints at the above
URL.

• Seed Nightly Cycle (Optional) - This is an optional section to auto-seed the nightly jobs in
the new schedule. Entering a Schedule Name and turning on this switch creates a basic
batch schedule by seeding the Nightly cycle with default start and end jobs.

Schedule Settings and Connections Configuration
Select the Schedules tab on the System Configuration screen to configure the settings and
connections for an environment.

The following information is shown for each environment:
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• Display Schedule Name.

• Schedule version number.

• Schedule name abbreviation (in parenthesis).

Note

This is the name to be used when calling POM APIs.

• Business Date - Date for which the specific schedule's batches will run next.

• The system options are a set of key-value pair of attributes and values specific to the given
schedule such as location of directories or throttle enabling setting. System options can
also be used to define shell script warning or error exit codes. If any such codes are
specified, they will cause a shell-script-based job to fail or complete with warning.

Examples of system options:

– Last Schedule Update - Last date on which the schedule was updated.

– Patch Mode - Enable/disable the patch mode to activate/cancel a patch respectively.
This switch is turned on when the POM application or an individual schedule is in the
process of being patched. In this case, POM will block any new execution requests for
the affected schedule(s). The switch is then turned off when the patch is done. It is not
recommended for users to alter this switch on this screen except to turn it off in some
situations. The most common situation is when patching is held up or errors out and
the patch is to be ignored so that users can resume using the application.

– Patch Source - Multiple applications can now put a Batch Schedule in patch mode,
when needing to pause batch to upgrade their schedule or for other reasons. Patch
source will show all the source systems that have put the schedule in patch mode. put
the schedule in patch mode.

• System Options link

Each Schedule is associated with a number of system options specific to its environment
and settings. Those can be edited by clicking the System Options link located next to the
Business Date.
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Figure 2-31    Edit System Options

The system options are a set of key-value pair of attributes and values specific to the given
schedule such as location of directories or throttle enabling setting. System options can
also be used to define shell script warning or error exit codes. If any such codes are
specified, they will cause a shell-script-based job to fail or complete with warning.

Examples of system options:

Key Value

enableThrottling FALSE

WarningCode110 Some input files were not processed

ErrorCode40 Input file corruption detected

The user can alter the value of a system option by adding an Active Value in the Edit
window.

The user can also add and remove options.
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• Settings - See Edit Settings for details.

– Data Retention Days

– Long Run Average Time Multiplier

– External Dependencies

– InterSchedule Dependencies

• Throttling - See Edit Throttling for details.

– Job Agent Throttle Limit

• Environment - See Edit Environment for details.

– Job Agent name (for example, RPASCE). This also acts as a link which, when clicked,
opens the Job Agent Configuration Window.

– Job Agent version

• External Configuration - See Edit External Configuration for details.
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– External URL

– External Status Update Mode

– Credentials

• Job Type - See Create / Edit Job Type for details.

– Job Type - For example, RDS.

Edit Settings
To edit the settings for an environment, click the edit icon  in the Settings section to open the
Settings window.
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Figure 2-32    Edit Settings Window

The following settings are available in this window:

• Data Retention Days - Number of days for which data is to be retained.

Note

By default, logs are retained for 30 days, based on the Object Store retention
setting.

• Long Run Average Time Multiplier - Used to calculate when a job is considered long
running.

If a Threshold Run Time is specified on the Edit Job popup of the Batch Administration
screen, then a job is deemed long running if its current run time exceeds that value.

Otherwise, if a Threshold Run Time is not specified, then the job is deemed long running
when its current run time exceeds this Long Run Average Time Multiplier times the
average run time of that job + Long Running Tolerance Level. The value for the Long
Running Tolerance Level can be overridden by changing the value of batch schedule
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variable defaultLongRunningToleranceLevel on the System Options screen accessed
from the System Configuration screen. The value is in seconds.

For example, if a job's average run time is 3 minutes, and the Long Run Average Time
Multiplier is 3, and the Long Running Tolerance Level is 6 minutes, then the job is
considered long running if it has been running for at least 15 minutes. A notification is sent
when a job is deemed long running.

If the Threshold Run Time field for a job is 0 or blank, and there is no history of job runs, a
job will be considered long-running when its run time exceeds the default long running
threshold run time of 10 minutes. This default value can be overridden by changing the
value of batch schedule variable defaultLongRunningThresholdRunTime on the System
Options screen accessed from the System Configuration screen. The value is in seconds.

• Default Average Time - Used instead of multiplying a job’s average run time by the
Multiplier (defined on this screen) when the job does not have run history. This is to
determine whether a job can run on a certain node when the Node Repaving is upcoming.
For example, say a node’s repaving is taking place in 30 minutes. If a job has a run history
and its average runtime multiplied by the Multiplier is greater than 30 minutes, then the job
will run on a different node. If however the job has no run history, then this Default Average
Time is used instead.

• Background Jobs - Enable or disable background jobs.

• External Dependencies - A switch for enabling or disabling external dependencies.

• InterSchedule Dependencies - A switch for enabling or disabling InterSchedule
dependencies.

• Repave Strategy - This strategy together with the next field's value is used to determine if
a job should be allowed to run on a particular server node. When a node is scheduled to
be repaved (updated with the latest software patch), no batch job should be running on it
when the repave starts. To prevent such a situation, a best guess is needed as to when a
node should stop accepting jobs to be run. There are two strategies for determining when
that time is:

– Fixed: Uses the next field's value (Window Duration - in seconds) to determine the
time at which the node will start rejecting requests for running jobs. For example, if this
value is 3600 seconds, the node will stop accepting requests one hour before the
repave starts.

– Variable: Multiplies the next field's value (multiplier) with the job's average run time to
determine if the node likely has enough time to run the job to completion. For example,
if the multiplier is three and the job about to be submitted for running on this node has
an average run time of five minutes and the repave is due to start at a time longer than
the 15 minutes (the product of the two numbers), the job will be allowed to run.
Otherwise, it won't be.

Note

If a job does not have a run history (therefore does not have an average
runtime), then the Default Average Time (also defined on this screen) is used
instead of multiplying a job’s average run time by the multiplier field defined
next.

• Window Duration / Multiplier - This field is dynamically altered on the screen depending
on the previous field's value and is used in conjunction with the previous field. See the
previous field's explanation for details.
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• Target Batch Duration - This is in minutes. This value is used as a target/baseline on the
bar graph in the Batch Timings section of the Nightly Batch Summary report. See the 
Nightly Batch Summary report in the Reports section of this guide.

Select OK to save the changes or select Cancel to exit the window without saving changes.

Edit Throttling
The throttling settings can be changed by selecting the edit icon  in the Throttling section to
open the Throttling window.

Figure 2-33    Edit Throttling Window

This window allows for update of the throttling value for each application hosted on this Job
Agent.

Select OK to save the changes or select Cancel to exit the window without saving changes.

Edit Environment
The environment settings can be changed by selecting the edit icon  in the Environment
section to open the Environment window.

Note

One schedule can be supported by one or multiple Job Agents. Usually, the mapping
is one Job Agent to an application.

Also, the Job Agent is a component of POM responsible for submitting the request to
execute a batch job.
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Figure 2-34    Edit Environment Window

At the top of the Environment window, the user can set the Platform Services URL.

The window then provides two tabs: the Job Agents tab and the Services tab.

On the Job Agents tab, the user can add or change the following Agent related information:

• Application - application name

• Name - Agent's name

• Job Agent Version - Release version of the Agent

• Job Agent URL

On the Service tab, the user can add or change services related information. These are
services that POM integrates with, such as BDI Process Services, IDCS or OCI IAM, and all
services corresponding to the different applications with service-type batch jobs.

Select OK to save the changes or select Cancel to exit the window without saving changes.

Job Agent Configuration Window
The Job Agent Configuration window displays configuration information about the selected
Agent.
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An Agent is the component usually deployed alongside the application for which the batch
runs. It receives requests from the POM application, usually deployed on a common server.
These requests direct the agent to invoke the actual job execution on the target application.

Select the Done button to close the window.

Figure 2-35    Job Agent Configuration Window

This window displays information about the Agent's Configuration Settings, Throttle Groups
and Job Types.

It also displays a Configuration URLs section which lists service URLs that POM needs to
operate. These include service URLs for calling endpoints to execute batch in the case where
the jobs are service-based (versus shell-script-based) and are of pre-defined job types such as
RI, RASE and RPAS.

The Throttle Groups section displays throttle limits (the maximum number of jobs that can
execute concurrently). These are defined either on the batch schedule spreadsheet or on the
Throttling section of this System Configuration screen.

Chapter 2
System Configuration

User Guide
G38769-01
Copyright © 2025, Oracle and/or its affiliates.

July 23, 2025
Page 57 of 143



The Job Types Configuration section displays all custom job types defined either on the
batch schedule spreadsheet or on the Job Type section of this System Configuration screen.

This window also features a Sync With POM button (formerly called Publish). When clicked, it
will synchronize the information on this screen from POM to the Job Agent. These changes are
also synchronized automatically to the Job Agent upon the daily creation of a new scheduler
day.

Edit External Configuration
The external configuration settings can be changed by selecting the edit icon  in the External
Configuration section to open the External Configuration window. The ReST service call for
External Status Update (Callback) allows both Basic Auth and OAuth2.

Figure 2-36    Edit External Configuration Window - Basic
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Figure 2-37    Edit External Configuration Window - OAuth

The following settings are available in this window:

• External Status URL - Customer system's URL that is called when POM is to notify the
customer's system. Note that this calling feature is also referred to as Callback.

• External Status URL Description - An optional description of the external system’s URL.

• External Status Update Mode - Job status for which POM is to call the customer's URL.
This menu has the following options:

– ALL - POM will make a call for each job's execution regardless of success or failure.

– FAILED - POM will make a call only for failed jobs.
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– NONE - POM will never make a call.

• Auth Type - The authentication type to use for the external callback URL. The value can
be OAuth or Basic.

• OAuth URL - The URL to obtain the token from the authentication provider. This is only
required for Auth Type of OAuth.

• OAuth URL Description - The description of the authentication provider. This is an
optional field and only available for Auth Type of OAuth.

• OAuth Scope - The scope to request for the token from the authentication provider. This is
only required for Auth Type of OAuth.

• Update Credentials - When clicked, Username and Password fields are shown. Setting
these values will update the credentials POM uses to call the customer's URL.

Select OK to save the changes or select Cancel to exit the window without saving changes.

Job Types
Job Types window displays a table of configured job types. The user can edit or delete an
existing row or create a new job type.

See the “Generic ReST Jobs” chapter of the POM Implementation Guide for additional details
on setting up custom schedules with custom job types.

Figure 2-38    Job Types Table

Each row contains the fields:

• Job Type - A short, alphanumeric identifier of the job type. This typically reflects the
system or application where associated jobs are to be executed (for example, RDS).

• URL - Base URL for endpoints at the destination system where batch is to be Invoked (for
example, https://server/services/batch).

•  Job Start - Endpoint for invoking the execution of a job.

•  Job Restart - Endpoint for restarting the execution of a job after failure.

•  Job Status - Endpoint for POM to fetch the status of a started job.

•  Job Kill - Endpoint for terminating the execution of a running job.

•  Job Logs - Endpoint for fetching the log(s) for a job.

•  Validation - Endpoint for validating that the endpoints are reachable.

• Scope - Authentication scope for accessing the above endpoints.
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• Custom Credential - Displays a tick mark if the credential is custom created by the user
for that job type. Else, blank.

Create / Edit Job Type
A new job type can be created by selecting the Create icon  in the Job Types section to open
the Job Type Configuration window. The system default OAuth Credentials can be used for
authentication.

Alternatively, custom credentials with the IDCS URL and the Client ID and Client Secret can be
used for authentication using an IDCS instance other than POM's.

Figure 2-39    Create Job Type – Using System Default OAuth Credentials
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Figure 2-40    Create Job Type – Using Custom OAuth Credentials – IDCS URL

Figure 2-41    Create Job Type – Using Custom OAuth Credentials – Client ID and Secret

Additionally, an existing job type configuration can be changed by selecting the edit icon .
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Figure 2-42    Edit Job Type

Note

If the selected job type is using custom credentials, the popup will also show the
corresponding client id.

Select OK to save the changes or select Cancel to exit the window without saving changes.

See the “Generic ReST Jobs” chapter of the POM Implementation Guide for additional details
on setting up custom schedules with custom job types.

System Settings
Select the System tab in the System Configuration screen to view the system configuration for
Process Orchestration and Monitoring.

Figure 2-43    System Information Screen
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Edit System Settings
Select the edit icon  (not shown) located at the rightmost of the System Information window
to enable the editing of information on this window.

Figure 2-44    Edit System Settings Window

The following settings are available in this window:

• Environment Name – This is the physical environments name such as <customer name>
stage 1.

• Customer Name

• Process Services URL – This URL is set at install time and cannot be changed on this
window. It shows the value of POM's services URL.
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• Read Timeout – This field sets an execution time limit on network calls made by POM.
The default is 300000 milliseconds (5 mins). Although the field has no on-screen
validation, the maximum timeout is bound by the Load Balancer maximum configuration for
ReST endpoints, which at this time is 300000 milliseconds (5 mins).

•   Connect Timeout – This field sets the connection establishment time limit on network
calls made by POM. The default is 120000 milliseconds (2 mins). Although the field has no
on-screen validation, the maximum timeout is bound by the Load Balancer maximum
configuration for ReST endpoints, which at this time is 300000 milliseconds (5 mins).

•  RDS Integration – Flag indicating whether POM is integrated with Retail Data Store
(RDS)..

•  Retail Data Store URL – Shows the value of the RDS URL. It can be updated on this
window. It can be updated only when the RDS Integration switch is enabled.

Select OK to save the changes or select Cancel to exit the window without saving changes.

Remove Existing Schedule
Select the Remove Existing Schedule button to open the Remove Schedule dialog. This
screen removes the selected schedule (from the drop down) from the POM Application.

Figure 2-45    Remove Schedule Screen

Global Edit
Select the Global Edit button to open the Global Edit screen. This screen sets configurations
for all the schedules. Refer to the sections above for explanation of the different configurations.
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Figure 2-46    Global Edit Screen

Use the Apply check boxes to activate the fields for the settings to be applied to all schedules.
The following settings can be applied to all schedules:

• Data Retention Days

• Long Run Average Time Multiplier

• Background Jobs

• External Dependencies

• InterSchedule Dependencies

• External URL

• External Status Update Mode

• Repave Strategy

• Credentials:

– Username

– Password

Batch Administration
The batch administration screen provides the ability to maintain information specific to the
batch schedule.

Select Batch Administration in the Navigation Area to open the Batch Administration tab.
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Figure 2-47    Batch Administration

Batch Administration Header
The Batch Administration header includes the following options:

1. Batch Tiles - There is a batch tile for each software environment Process Orchestration
and Management connects to. Select a tile to show the batch processes for that
environment. See Batch Tiles for more information about these tiles.

2. Cycle Tabs - Displays the cycles for which batch information is to be maintained.

Select a cycle tab to see the batch details for that cycle. The following cycles are available:

• Nightly

• Recurring

• Standalone

3. Sync with MDF – MDF is the Module Definition Framework maintained in the Retail Home
Customer Module Management module of Retail Home. Using the Sync with MDF button
in POM will sync the modules defined in POM with those in Retail Home. Nightly jobs
belonging to those modules are then enabled or disabled based on their state in Retail
Home.

When Sync with MDF is clicked for the selected application schedule, the user is
presented with a warning message advising that jobs may be enabled or disabled as a
result of the synch action.

Figure 2-48    MDF Sync – Warning Message
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After the sync is complete, a JSON file with the batch schedule summary is downloaded.
This file contains the current and previous status of an application and module in MDF and
POM after sync.

The following is a sample of that JSON file:

{
    "scheduleName":"RI","synced":true,"enabledModules": [
        {
            "state":"MATCHED_MODULE",
            "mdfStatus":"ENABLED",
            "prevMdfStatusInPom":"ENABLED",
            "prevStatusInPom":"ENABLED",
            "publishToPom":true,
            "applicationName":"RI",
            "moduleName":"RMI_SI_ONORDER",
            "matchedModule":true
        },
        {
            "state":"MATCHED_MODULE",
            "mdfStatus":"ENABLED",
            "prevMdfStatusInPom":"ENABLED",
            "prevStatusInPom":"ENABLED",
            "publishToPom":true,
            "applicationName":"RI",
            "moduleName":"RMI_SI_WHOLESALE",
            "matchedModule":true
        },
        {
            "state":"MATCHED_MODULE",
            "mdfStatus":"ENABLED",
            "prevMdfStatusInPom":"DISABLED",
            "prevStatusInPom":"ENABLED",
            "publishToPom":true,
            "applicationName":"RI",
            "moduleName":"RCI_SI_SALES",
            "matchedModule":true
        }
    ]
}

Also, the status of the updated jobs is changed to either 'Loaded' or 'Disabled' based on
the module activation/deactivation in Retail Home’s Customer Modules Management.

4. Export - Use this button to export Schedule Configuration or Custom Entities for the
selected schedule and cycle. Schedule configuration includes Scheduler tasks, throttle limit
values, data retention values, notifications settings and (most importantly) which jobs are
enabled or disabled. Custom Entities include schedule customizations that a user has
performed on this Batch Administration screen such as addition of custom flows,
processes and jobs.

When clicked, the user is presented with a dialog for selecting the data to export –
Schedule Configuration or Custom Entities.

If 'Schedule Configuration' is selected, then the type of file to export (Excel or JSON) also
has to be selected.
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Custom Entities can only be exported as JSON.

Depending on the user's browser setting, the file is either saved in the default local file
system directory or a file save/open dialog is presented first.
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If the export is done for the purpose of applying the same configurations on another
environment (Lift & Shift), the user is recommended to export to a JSON file. This file is
then used in the Import Config function (explained below) to import the configurations into
another environment.

The user has the option to manipulate the exported file before importing back into the
same environment or a different one. In that case an export to an Excel file is more
suitable for ease of manipulation. Caution needs to be taken when manipulating the
content of the exported file, especially for maintaining proper data format.

Refer to the “Export/Import Schedule Configuration” chapter of the Process Orchestration
and Monitoring Implementation Guide for details on applying changes to the exported
spreadsheet before importing it back in.

5. Import - Use this button to import Schedule Configuration or Custom Entities for the
selected schedule and cycle. When clicked, the user is presented with a dialog to select
the desired type of data to import – Schedule Configuration or Custom Entities. See 
Export above for a brief explanation of each.
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If the Schedule Configuration import is selected, the user can select to import Scheduler
tasks configuration and/or Jobs configuration and/or Notifications configuration. The jobs
configuration includes such settings as throttle values, data retention values, enabled/
disabled setting and Job Start/Completion notifications. The Scheduler tasks are those
directives for the POM Scheduler to run the different batch cycles at specified times. The
Notifications configuration includes e-mail addresses and retention periods associated with
the different notification types.

Chapter 2
Batch Administration

User Guide
G38769-01
Copyright © 2025, Oracle and/or its affiliates.

July 23, 2025
Page 71 of 143



The user can also select to import Custom Entities and provide the JSON file containing
the custom entities' data.

Once the import type is selected and the Import button is clicked, the user is presented
with a file selector dialog (not shown). User can then choose to import a JSON or an Excel
file.

6. When a schedule is being upgraded using the Schedule Maintenance screen or when the
schedule upgrade has failed or when a schedule is being synced, the user is prevented
from most activities on the Batch Monitoring and on the Batch Administration screen.

Batch Tiles
Each tile displays the following information:
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Figure 2-49    Batch Tile

1. Schedule Name and Version - Displays the abbreviation of the application or application
group and the software version. The display schedule name can alternatively be displayed
here instead of the default schedule name. The display schedule name can be configured
on the Schedule tab of the Batch Schedule spreadsheet

2. Cycles and Statuses - Displays the number of batch jobs for nightly / recurring cycle and
number of ad hoc flows / processes for standalone cycle.

Batch List
The information in the batch list depends upon the cycle chosen:

• Nightly

• Recurring

• Standalone

Actions Menu and Icons
Actions Menu and Icons

See Action Menu and Icons for common actions that can be performed through the Action
menu and the icons. You can also perform the following actions:

Table 2-2    Batch Jobs - Actions Menu/Icons and Description

Actions Menu/Icons Description

Edit and Edit icon Select an item in the table, then select Actions > Edit or the edit
icon  to edit the item.

Enable All Use the Actions > Enable All or the Enable All button to put the
process on hold.

Disable All Use the Actions > Disable All or the Disable All button to skip
the process.

View Menu
See View Menu for information about the options in the View menu.
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View Flow Diagram
When clicked, the View Flow Diagram button displays a visual representation of a flow. It
shows a flow diagram of the processes in a flow and their dependencies as links. This is
applicable for Nightly, Recurring and Standalone cycles. The user can then click on a particular
Process in the diagram to see the list of its jobs in the sequential order of execution.

Figure 2-50    Flow Diagram

Filter by Process Name
When filtered by the Process Name, the flow Diagram displays and highlights the Process
Name in blue.
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Zoom In
Zoom in the flow diagram to get a larger view of a section of the flow.
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Zoom Out
Zoom out the flow diagram to view more processes.

Expand All
The Expand All button expands all the processes to get a view of their jobs. Individual
processes also can be expanded by clicking on the + sign in the left top corner of each process
block.

Collapse All
The Collapse All button collapses all processes, hiding their jobs.

Fit to Window
Fit to Window fits the complete Flow Diagram in the browser window.
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Export as PDF
Export as PDF exports the visible section of the screen to PDF.
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Enabled / Disabled Process
Enabled and disabled processes are shaded in green and grey respectively. The labels can
also be seen in the footer.

Linked Processes
When hovered over a link, the linked processes details are displayed.

Nightly
The nightly cycle displays the following information for each batch:
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Figure 2-51    Nightly Batch List

• Enabled

• Job - Click the Job to open the batch in the Batch Job Details screen.

• Process Name

• Base Priority - An optional number between 1 and 10 (10 being highest priority) assigned
to a process-job combination. This number determines the execution priority for the job
amongst concurrent job run requests in a limited throttled setting. The base priority is the
value initially seeded from the spreadsheet for this process-job.

• Active Priority - The current priority (1-10) value once altered from the UI. This value if
present supersedes the base priority.

• External Associations – Indicates with a checkmark whether the job is associated with any
enabled external association such as Custom Dependency, Inter-Schedule Dependency,
Schedule Link and External Dependency. The batch list table can also be filtered based on
the External Associations using the Filter dropdown in the column.

• Application - A schedule may be made up of multiple applications. There needs to be at
least one application.

• Module - An application may be made up of multiple modules. Modules within an
application are optional.

• Base Phase - An optional alphanumeric phase assigned to a process-job for grouping of
jobs in the Nightly cycle. This is used for reporting purposes only. The Nightly Summary
Report will then report total run time and elapsed time by Phase. The base phase is the
value initially seeded from the spreadsheet for this process-job.

• Active Phase - The current phase value once altered from the UI. This value, if present,
supersedes the base phase.

• Base Parameter - A job may be run with a list of input parameters. This column always
shows the original list of parameters.

• Active Parameter - This column shows the customized list of parameters.

• Job Type - A Job Type is an attribute of a Job in POM and signifies the kind of Job that is
run. POM has the following pre-built Job types. Other custom job type can be used that are
built using the Job Type feature of the System Configuration screen.

– EXEC - For all shell-script based jobs

– RI - DIS-based jobs for the RI schedule
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– RASE - DIS-based jobs for the RSP schedule

– BDI - BDI Jobs

– RPAS - RPAS-Web Service jobs for the RPAS schedule

– OB – OB-based jobs for the OB schedule

– OMS – OMS-based jobs for the OMS schedule

– RDS – RDS-based jobs

• Kill Cleanup Script - Name of a script that will be executed after the kill is performed. This
is an optional field as not all jobs require cleanup after termination.

• External Status Update - Job status for which POM is to call a customer's URL. The URL is
defined in the External Configuration section of the System Configuration screen. This
column has the following possible values:

– ALL - POM will make a call for this job's execution regardless of success or failure.

– FAILED - POM will make a call only for if this job fails.

– NONE - POM will not make a call.

• Notification At

– Start of Job – Send notification of type JobStarted when the selected job starts.

– Completion of Job - Send notification of type JobCompleted when the selected job
completes successfully. Note that there is a separate notification of type Error that is
sent when a job fails.

• Skip On Error - Skip this job if it fails.

• Threshold Run Time (Seconds) - Amount of time greater than which the job is deemed
long running. If a Threshold Run Time is specified here, then a job is deemed long running
if its current run time exceeds that value. Otherwise, if a Threshold Run Time is not
specified, then the job is deemed long running when its current run time exceeds the Long
Run Average Time Multiplier (defined on the Edit Settings popup of the System
Configuration screen) times the average run time of that job + Long Running Tolerance
Level. The value for the Long Running Tolerance Level can be overridden by changing the
value of batch schedule variable defaultLongRunningToleranceLevel on the System
Options screen accessed from the System Configuration screen. The value is in seconds.

For example, if a job's average run time is 3 minutes, and the Long Run Average Time
Multiplier is 3, and the Long Running Tolerance Level is 6 minutes, then the job is
considered long running if it has been running for at least 15 minutes. A notification is sent
when a job is deemed long running.

If the Threshold Run Time field for a job is 0 or blank, and there is no history of job runs,
the job will be considered long-running when its run time exceeds the default long running
threshold run time of 10 minutes. This default value can be overridden by changing the
value of batch schedule variable defaultLongRunningThresholdRunTime on the System
Options screen accessed from the System Configuration screen. The value is in seconds.

• Notes

• Job Name

• Job Wrapper Name

• Days of the Week - Days of the week for which the job is to be run.

The user can select one or multiple batch job(s) and click the Edit icon to edit information for
one or more batch jobs.
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Figure 2-52    Edit Nightly Batch Window for One Job
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Figure 2-53    Edit Nightly Batch Window for Multiple Jobs

The following information can be updated for each batch from the Edit window:

• Job Type – Choose from following pre-built Job types:

– EXEC - For all shell-script based jobs

– RI - DIS-based jobs for the RI schedule

– RASE - DIS-based jobs for the RSP schedule

– BDI - BDI Jobs

– RPAS - RPAS-Web Service jobs for the RPAS schedule

– OB – OB-based jobs for the OB schedule

– OMS – OMS-based jobs for the OMS schedule

– RDS – RDS-based jobs. Unlike all other job types, jobs with an RDS job type run
synchronously and therefore have a max execution limit of 5 minutes. This limit is
configurable on the System Configuration screen.
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Other custom job type can be used that are built using the Job Type feature of the System
Configuration screen.

•  Enable Job – Enable or disable a job

•  Priority - The user can change the Priority of a job with a value from 1-10 (With 10 being
the highest and 1 being the lowest and 0 as default value meaning no priority set). As long
as the Priority is not modified on the UI, it can be overridden from the spreadsheet.
However, once modified on the UI, the priority cannot be overridden from the spreadsheet,
but only from the UI.

•  Phase – The user can select a saved phase (if any) from the dropdown. Alternatively, the
user can type in a new alphanumeric value.

•  Parameters – Add or remove from the customized list of parameters, if allowed for that
batch.

•  Kill Cleanup Script - Name of a script that will be executed after a kill is performed.

•  External Status Update - Job status for which POM is to call a customer's URL. The URL
is defined in the External Configuration section of the System Configuration screen. This
column has the following possible values:

– ALL - POM will make a call for this job's execution regardless of success or failure.

– FAILED - POM will make a call only for if this job fails.

– NONE - POM will not make a call.

• Notification At

– Start of Job – Send notification of type JobStarted when the selected job starts
execution.

– Completion of Job - Send notification of type JobCompleted when the selected job
completes successfully. Note that there is a separate notification of type Error that is
sent when a job fails.

• Skip On Error - Skip this job if it fails.

• Threshold Run Time (Seconds) - Amount of time greater than which the job is deemed
long running. If a Threshold Run Time is specified here, then a job is deemed long running
if its current run time exceeds that value. Otherwise, if a Threshold Run Time is not
specified, then the job is deemed long running when its current run time exceeds the Long
Run Average Time Multiplier (defined on the Edit Settings popup of the System
Configuration screen) times the average run time of that job + Long Running Tolerance
Level. The value for the Long Running Tolerance Level can be overridden by changing the
value of batch schedule variable defaultLongRunningToleranceLevel on the System
Options screen accessed from the System Configuration screen. The value is in seconds.

For example, if a job's average run time is 3 minutes, and the Long Run Average Time
Multiplier is 3, and the Long Running Tolerance Level is 6 minutes, then the job is
considered long running if it has been running for at least 15 minutes. A notification is sent
when a job is deemed long running.

If the Threshold Run Time field for a job is 0 or blank and there is no history of job runs, the
job will be considered long running when its run time exceeds the default long running
threshold run time of 10 minutes. This default value can be overridden by changing the
value of batch schedule variable defaultLongRunningThresholdRunTime on the System
Options screen accessed from the System Configuration screen. The value is in seconds.

• Notes

• Days of the Week - Days of the week for which the job is to be run.
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Recurring
The Recurring cycle includes an Hourly Cycle menu. Select an hour in this menu to choose
the hour of the day during which the displayed jobs will run.

The recurring cycle includes the following information for each batch:

Figure 2-54    Recurring Batch List

• Flows - Select a flow in the Flows list to view all jobs for that flow. The following information
is shown for each flow:

– Flow Name

– Enabled or Disabled

• Jobs - The Jobs list shows the following information for each job. The user can also update
the job by selecting it and clicking on the Edit icon. Refer to the Nightly cycle above for an
explanation of each field:

– Enabled

– Job - Click the Job to open the batch in the Batch Job Details screen.

– Process Name

– Base Priority

– Active Priority

– Application

– Module

– Base Phase

– Active Phase

– Parameters

– Active Parameter
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– Job Type - Job Type of 'EXEC' Indicates that the job executable is shell script based.
All other job types, such as 'BDI', 'RI', and so on, indicate that the job is service-based.
Service-based job types require different configurations than shell-script based.

– Kill Cleanup Script - Name of a script that will be executed after the kill is performed.
This is an optional field as not all jobs require cleanup after termination.

– External Status Update

– Skip On Error

– Threshold Run Time (Seconds)

– Notes

– Job Name

– Job Wrapper Name

– Days of the Week

The user can select a batch and click the Edit icon to edit the batch. Refer to the Nightly cycle
above for an explanation of each field in the Edit window.

Standalone
The standalone cycle includes the following information for each flow, process, and job:

Figure 2-55    Standalone Batch Sections

Left Pane of the Screen

• Create Custom Entities - The following options are listed when clicked:

– Create Flow

– Create Process

• Filter by Invokable Name – Search for an invokable by entering a search term and clicking
on Enter. An invokable can be a flow or a process that does not belong to a flow.
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• Filter by Job – Search for invokable by entering job name or job-enabled value.

• Flows/Processes - The following information is shown for each flow/process:

– Flow/Process Name

– Enabled or Disabled

– Flow/Process Label

Right Pane of Screen

• Jobs - Select an invokable (flow or process) from the left pane to view all jobs for that flow
or process. The Jobs list shows the following information for each job. The user can also
update the job by selecting it and clicking on the Edit icon. Refer to the Nightly cycle above
for an explanation of each field:

– Enabled

– Job - Click the Job to open the batch in the Batch Job Details screen.

– Process Name

– Base Priority

– Active Priority

– Application

– Module

– Base Phase

– Active Phase

– Parameters

– Active Parameter

– Job Type - Job Type of 'EXEC' Indicates that the job executable is shell script based.
All other job types, such as 'BDI', 'RI', and so on, indicate that the job is service-based.
Service-based job types require different configurations than shell-script based.

– Kill Cleanup Script - Name of a script that will be executed after the kill is performed.
This is an optional field as not all jobs require cleanup after termination.

– External Status Update

– Skip On Error

– Threshold Run Time (Seconds)

– Notes

– Job Name

– Job Wrapper Name

– Days of the Week

Create Custom Entities - Create Flow
The user can select Create Custom Entities and click on the Create Flow option to create a
new flow and its associated process(es) and job(s).
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The following information can be added to create a new flow:

• New Flow Details

– Flow Name – Name of the flow ending with _CFLOW

– Comment

– Description

• Processes in Flow

Processes can be added to the flow by either creating a new process or adding an existing
process or importing processes from an existing flow.

1. Create New Process

As this is the first process in the flow, the Processes in Flow field is populated with
this process as shown below, marking it as the First and Last process.
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2. Add Existing Process

As we have already created the first process for the custom flow, the first process is
the Predecessor for the next created process.

3. Import Process from Existing Flow – Select All
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All processes from the selected flow are added.

4. Import Process from Existing Flow – Import Selective Process
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Only the selected processes from the flow are added.

After adding the desired processes, click the Next button to add job(s) to the processes.
Every process in the custom flow should have at least one job.
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• Jobs in Process

New or existing jobs can be added to the selected Process by either creating a new job or
adding an existing job or importing a job from an existing process.

1. Create New Job

Figure 2-56    Create New Job – Job Type: EXEC

Figure 2-57    Create New Job – Job Type other than EXEC (For example, RI,
RDS, BDI, and so on)

– Job Name

Uniquely identifies a job. The Job Name should be in upper case with no spaces.
Use an underscore if needed. It should end with _CJOB. If the same job is part of
multiple processes (for example, different parameters are passed), define a
separate job for it.

– Description

Short description of the batch job. There should be no special characters.

– Job Type

* Can be one of the following values: EXEC, RI, RASE, BDI, RPAS, OMS, OB, or RDS.
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* Can also be a custom job type defined either in the JobType tab of the Batch
Schedule spreadsheet or built using the Job Type feature on the System
Configuration screen.

– Application

This holds the application that the batch job belongs to. It should be a valid
application defined in the Application tab of the Batch Schedule spreadsheet.

– Skip On Error

If the switch is on, it indicates that the job should be skipped if it fails, and the
batch schedule should continue to run. Otherwise, the batch schedule is stopped.

– Fixed Parameter

If the switch is on, it indicates that the parameter value can be changed on the
Batch Administration screen. The switch should be on if the parameter cannot
have a default value, or if the parameter can have different values.

– Script Directory (Applicable only for EXEC Job Type)

Directory where the executable batch script is located.

– Batch Name (Applicable only for EXEC Job Type)

The name of the batch script to be executed which is located within the Script
Directory.

– Job Wrapper Name (Applicable only for EXEC Job Type)

Name of the batch file that encloses the executable batch scripts.

– Base Parameter

* This holds the entire parameter value to be passed into the job. This field is
case sensitive.

* For parameters that can have multiple values (for example, purge days
parameter), provide a default value so that the batch can still be executed.

* A placeholder parameter #JobCtxt.businessDate can be used for jobs that require a
POM business date parameter (DDMMYYYY format).

– Kill Cleanup Script

Absolute path of the cleanup script to be run after killing a shell script (EXEC) type
job from the POM UI. It can include arguments as well along with the script.

For example: /u01/retail/app/batch/app_cleanup_script.sh

– Days of the Week

Days of the week for which the job is to be run if scheduled. Select all if job is to be
run every day of the week.

For example, if a job is part of a process that runs every day and Days of the
Week is set to MONDAY and FRIDAY, this job will only run on those two days while
the rest of the jobs may run every day.

– Threshold Run Time (Sec)

Amount of time greater than which the job is deemed long running. If a Threshold
Run Time is specified here, then a job is deemed long running if its current run
time exceeds that value. Otherwise, if a Threshold Run Time is not specified, then
the job is deemed long running when its current run time exceeds the Long Run
Average Time Multiplier (defined on the Edit Settings popup of the System
Configuration screen) times the average run time of that job + Long Running
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Tolerance Level. The value for the Long Running Tolerance Level can be
overridden by changing the value of batch schedule variable
defaultLongRunningToleranceLevel on the System Options screen accessed
from the System Configuration screen. The value is in seconds.

For example, if a job's average run time is 3 minutes, and the Long Run Average
Time Multiplier is 3, and the Long Running Tolerance Level is 6 minutes, then the
job is considered long running if it has been running for at least 15 minutes. A
notification is sent when a job is deemed long running.

If the Threshold Run Time field for a job is 0 or blank and there is no history of job
runs, the job will be considered long-running when its run time exceeds the default
long running threshold run time of 10 minutes. This default value can be
overridden by changing the value of batch schedule variable
defaultLongRunningThresholdRunTime on the System Options screen
accessed from the System Configuration screen. The value is in seconds.

2. Add Existing Job

3. Import Job from Existing Process

After adding the desired job(s), click the Create button in the footer to create the
custom flow with its associated process and jobs.
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The custom flow and its jobs are created and displayed in the Standalone tab. A
Custom tag is also seen along with the flow name in the left pane to indicate that it
was a custom, user-created flow, as opposed to being seeded from the batch schedule
spreadsheet.

Enable the Custom Flow

The custom flow is disabled by default and can be enabled by clicking the enable/disable
switch. Enabling the Custom Flow also enables its batch jobs.

Edit the Custom Flow

The Custom Flow can be edited by clicking on the Edit icon below the flow name. The user
can then edit the flow details, add/edit/delete processes and add/edit/delete jobs.
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Delete the Custom Flow

The Custom Flow can be deleted by clicking the Delete icon below the flow name. For audit
purposes, a comment is required when deleting a custom flow.

Create Custom Entities - Create Process
The user can select Create Custom Entities and click the Create Process option to create a
new process and its associated job(s).

The following information can be added to create a new process:

• New Process Details

– Process Name – Name of the process ending with _CPROCESS.

– Comment
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– Description

• Jobs in New Process

New or existing jobs can be added to the selected Process by either creating a new job or
adding an existing job or importing a job from an existing process.

1. Create New Job

– Job Name

Uniquely identifies a job. The Job Name should be in upper case with no spaces.
Use an underscore if needed. It should end with _CJOB. If the same job is part of
multiple processes (for example, different parameters are passed), define a
separate job for it.

– Description

Short description of the batch job. There should be no special characters.

– Job Type

* Can be one of the following values: EXEC, RI, RASE, BDI, RPAS, OMS, OB, and
RDS.

* Can also be a custom job type defined either in the JobType tab of the Batch
Schedule spreadsheet or built using the Job Type feature of the System
Configuration screen.

* Note that, unlike all other job types, a job of job type RDS runs synchronously
and therefore have an execution limit of 5 minutes. This limit is configurable on
the System Configuration screen.

– Application

This holds the application that the batch job belongs to. It should be a valid
application defined in the Application tab of the Batch Schedule spreadsheet.

– Skip On Error

If the switch is on, it indicates that the job should be skipped if it fails, and the
batch schedule should continue to run. Otherwise, the batch schedule is stopped.

– Fixed Parameter

If the switch is on, it indicates if the parameter value can be changed on the Batch
Administration screen. The switch should be on if the parameter cannot have a
default value, or if the parameter can have different values.
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– Parameters

* This holds the entire parameter value to be passed into a shell script type job.
This field is case sensitive.

* For parameters that can have multiple values (for example, purge days
parameter), provide a default value so that the batch can still be executed.

* Placeholder parameter #JobCtxt.businessDate can be used for jobs that require a
POM business date parameter (DDMMYYYY format).

– Kill Cleanup Script

Absolute path of the cleanup script to be run after killing a shell script (EXEC) type
job from the POM UI. It can include arguments as well along with the script.

For example: /u01/retail/app/batch/app_cleanup_script.sh

– Days of the Week

Days of the week for which the job is to be run if scheduled. Select all if job is to be
run every day of the week. For example if a job is part of a process that runs every
day and Days of the Week is set to MONDAY and FRIDAY, this job will only run on
those two days while the rest of the jobs may run every day.

– Threshold Run Time (Sec)

Amount of time greater than which the job is deemed long running. If a Threshold
Run Time is specified here, then a job is deemed long running if its current run
time exceeds that value. Otherwise, if a Threshold Run Time is not specified, then
the job is deemed long running when its current run time exceeds the Long Run
Average Time Multiplier (defined on the Edit Settings popup of the System
Configuration screen) times the average run time of that job + Long Running
Tolerance Level. The value for the Long Running Tolerance Level can be
overridden by changing the value of batch schedule variable
defaultLongRunningToleranceLevel on the System Options screen accessed
from the System Configuration screen. The value is in seconds.

For example, if a job's average run time is 3 minutes, and the Long Run Average
Time Multiplier is 3, and the Long Running Tolerance Level is 6 minutes, then the
job is considered long running if it has been running for at least 15 minutes. A
notification is sent when a job is deemed long running.

If the Threshold Run Time field for a job is 0 or blank and there is no history of job
runs, the job will be considered long-running when its run time exceeds the default
long running threshold run time of 10 minutes. This default value can be
overridden by changing the value of batch schedule variable
defaultLongRunningThresholdRunTime on the System Options screen
accessed from the System Configuration screen. The value is in seconds.

2. Add Existing Job
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3. Import Job from Existing Process

After creating and adding jobs for the new process, click the Create button in the
footer to create the custom process with its associated jobs.
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The custom process and its jobs are created and displayed in the Standalone tab. A CUSTOM
tag is also seen along with the process name to indicate that it was a custom, user-created
process.

Enable the Custom Process

The custom process is disabled by default and can be enabled by clicking the enable/disable
switch.

Edit the Custom Process

The Custom Process can be edited by clicking the Edit icon below the flow name to edit the
process details and add/edit/delete jobs.

Delete the Custom Process

The Custom Process can be deleted by clicking the Delete icon below the flow name. For audit
purposes, a comment is required when deleting a custom process.

Batch Job Details
The Batch Job Details screen allows maintenance of various types of dependencies
associated with a batch job.
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Figure 2-58    Batch Job Details

Pre Dependencies
This section displays the following information about a job's pre-dependencies:

• Enabled - Switch to enable or disable the pre-dependency.

• Job

• Process

Post Dependencies
This section displays the following information about a job's post-dependencies:

• Enabled - Switch to enable or disable the post-dependency.

• Job

• Process
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External Dependencies
This section allows for the maintenance of the following information about a job's external
dependencies. An external dependency is normally a process internal to a customer's system.

• Enabled - Switch to enable or disable the external dependency.

• Job

• A Remove button is available to delete the external dependency.

Inter-Schedule Dependencies
This section allows for the maintenance of the following information about a job's inter-
schedule dependencies. An inter-schedule dependency is a dependency for the current job on
a job belonging to another batch schedule. The job for which this Jobs Detail screen is shown
will wait for the job entered here.

• Enabled - Switch to enable or disable the inter-schedule dependency.

• Job - Name of job belonging to the other schedule.

• Process - Name of process containing Job.

• Schedule - Name of other schedule containing the dependency.

• A Remove button is available to delete the inter-schedule dependency.

Custom Dependencies
This section allows for the maintenance of the following information about a job's custom
dependencies. A Custom Dependency is a dependency that includes entities (process/flow)
that are executed prior to the current job in Nightly or Recurring cycles. The nightly or recurring
job on which the dependency is placed is triggered once the dependency completes
successfully.

• Target Entity – Option to add either an Adhoc Flow or Adhoc Process

• Flows/Processes – List of Adhoc Flows or Processes.

• An Edit Sequence button is available to set the sequence of execution for the added
target flow/process.

Schedule Links
This section allows for the maintenance of the following information about schedule links for a
job. Schedule links are a way to link schedules together where the completion of the job in the
current schedule causes the start of execution of the dependent schedule.

• Enabled - Switch to enable or disable the schedule link.

• Job - Name of job belonging to the dependent schedule.

• Process - Name of process containing Job.

• Schedule - Name of the dependent schedule.

• A Remove button is available to delete the schedule link.
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Scheduler Administration
The Scheduler Administration screen displays information about the different cycles' Scheduler
tasks and allows for their administration.

When an application's batch schedule is initially seeded in POM, Scheduler tasks are created
for each of the different Nightly, Recurring, and Standalone cycles. An administrator would then
access the Scheduler Administration screen to configure the execution schedule for all
available tasks according to customer's needs.

Note

Scheduler tasks are not automatically seeded for Adhoc Custom Entities that are
created using the Create Custom Entities button on the Batch Administration screen.
Scheduler tasks for these custom entities need to be manually added using this
Scheduler Administration screen.

A scheduler task can be configured in one of many frequencies as depicted in the table and
Edit task screenshot below:

Frequency Description

Daily Run daily at the specified time

Once Run once at a specified date and time

Weekly Run every <day of a week> at the specified time

Monthly (By Date) Run on a particular day of each month at a specified
time; for example, on the 15th of each month at 10pm

Monthly (First Day of the Month) Runs at the beginning of every month

Monthly (Last Day of the month) Runs at the end of every month

Monthly (By Weekday) Runs on the First/Second/Third…./Last weekday of the
month. For example, Second Wednesday of the month

The Standalone (or Adhoc) cycle support a recurrence within each of the above frequencies.

Recurrence Description

Single Will run just once at the time defined on the frequency

Multiple Will run multiple times at regular intervals starting at
the time defined on the frequency

The following are restrictions enforced on scheduler task frequencies:

• Recurring cycle supports only Daily frequency. It does not support the MULTIPLE
recurrence.

• Nightly cycle supports only Daily and Weekly frequencies. It does not support the MULTIPLE
recurrence.

• When Nightly is setup with Weekly frequency, it needs to be setup for every day of the
week. This is due to the fact that when Nightly completes for a certain day, it sets up the
schedule for the next business day which cannot be skipped.
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Figure 2-59    Edit Scheduler Task Window

It is important to note that POM considers the POM business date, not the system date, to
identify the day/ date, while scheduling tasks.

Nightly Scheduler Task Administration
On the Scheduler Administration screen, the user selects a schedule tile at the top of the
screen and the Nightly tab right below the tile area. The Nightly cycle's Scheduler task is
shown in the tasks table of the figure below.

Note

There is only one Nightly Scheduler task, as there is only one Nightly batch run.
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Figure 2-60    Nightly Scheduler Task Administration

The user selects the only row available for the Nightly task, clicks the edit icon then edits the
scheduler configuration in the Edit Task Nightly popup. The popup includes the following
schedule information for the Nightly task:

• Enabled/Disabled

• Scheduled Time Zone

• Frequency - Possible values are: Daily, Once, Weekly, Monthly (By Date), Monthly (First
Day of Month), Monthly (Last Day of Month), and Monthly (By Weekday). However, only
the Daily and Weekly frequencies are feasible for the Nightly cycle.
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• Schedule Details - Based on the Frequency selection, the Schedule Details refreshes
accordingly:

– Frequency: Daily 'Run Every Day At' <Time AM/PM>.Note that when using the Daily
frequency, Nightly will run at the same time every day.

– Frequency: Weekly 'Run Every' <Day of the week> 'at' <Time AM/PM>.Add Another:
Adds another weekday for the same task. Note that when using the Weekly Frequency
for the Nightly cycle, it needs to be scheduled for every day of the week. Also note that
by using the Weekly Frequency, you can schedule Nightly to run at different times on
different days.

– Selecting any of the other frequencies (Once or any of the Monthly modes) results in
Error Message: Nightly cycle supports only Daily and Weekly frequencies.

Recurring Scheduler Tasks Administration
On the Scheduler Administration screen, the user selects a schedule tile at the top of the
screen then the Recurring tab right below the tile area then the hourly flow from the drop down
to the right of the Recurring tab. The Recurring flow's Scheduler tasks are shown in the tasks
table.

Figure 2-61    Recurring Scheduler Tasks Administration
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The user selects a task in the table, clicks the edit icon, then edits the scheduler configuration
in the Edit Task popup. The popup includes the following schedule information for the selected
task:

• Enabled/Disabled

• Scheduled Time Zone

• Frequency - Possible values are: Daily, Once, Weekly, Monthly (By Date), Monthly (First
Day of Month), Monthly (Last Day of Month), and Monthly (By Weekday). However, only
the Daily frequency are feasible for the Recurring cycle.

• Schedule Details - Based on the Frequency selection, the Schedule Details refreshes
accordingly:

– Frequency: Daily 'Run Every Day At' <Time AM/PM>.

– Selecting any of the other frequencies (Once, Weekly or any of the Monthly modes)
results in Error Message: Recurring cycle supports only Daily frequency.

Standalone Scheduler Tasks Administration
In the Scheduler Administration screen, the user selects a schedule tile at the top of the screen
and the Standalone tab right below the tile area. The Standalone cycle's Scheduler tasks are
shown in the tasks table sorted by name by default.
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Figure 2-62    Standalone Scheduler Tasks Administration

If the row’s Task Configuration column contains a Show More Details link, clicking the link
opens a pop-up window displaying the task's schedule.

The user can either edit the schedule time for each task in-line, or select a task then click the
edit icon to change any of the fields shown in the Edit popup below.

The user selects a task in the table, clicks the edit icon then edits the scheduler configuration
in the Edit Task popup. The popup includes the following schedule information for the selected
task:

The user can also create and delete Standalone scheduler tasks.

Note

The user has the option to enter a blank time as long as a frequency in minutes is
entered. This will cause the first occurrence to execute immediately.
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• Enabled/Disabled

• Scheduled Time Zone

• Frequency - Possible values are: Daily, Once, Weekly, Monthly (By Date), Monthly (First
Day of Month), Monthly (Last Day of Month), and Monthly (By Weekday).

• If the 'Recurrences' is more than 1, then 'Starting Every n Minutes' has to be specified.

• Schedule Details - Based on the Frequency selection, the Schedule Details refreshes
accordingly.

•  Nightly Start - This drop-down field has two possible options:

- The Prevent start during nightly drop-down option prevents the task from running while
the Nightly batch cycle is running. However, it won’t stop a run that is in progress when the
Nightly process starts.

- The Do not start nightly drop-down option prevents the Nightly batch cycle from starting
when the ad hoc request has arrived. It will also prevent the ad hoc job from starting when
the Nightly process is running.

Schedule Maintenance
The Schedule Maintenance screen displays information about the batch schedule upgrade
results. You can upgrade a batch schedule to a new version through this screen.
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Figure 2-63    Schedule Maintenance Tab

1. Batch Tiles - There is a batch tile for each schedule available in Process Orchestration
and Management. Select a tile to show the history of the selected schedule's upgrades or
available upgrades.

2. Import Latest Schedule - Use this button to upgrade the selected schedule from a
spreadsheet. When clicked, a file selector dialog is displayed (not shown). The import file
is a spreadsheet.

3. Update History Status List - Displays information about each past or available upgrade of
the batch schedule. This menu displays the following information for each batch upgrade:

• Upgrade Status

• Version

• Date Upgraded

• Description

4. Actions

• Change Summary - Use this button to view the schedule change summary. These are
the changes that took place in the selected schedule upgrade compared to the
previous version. These changes include entities added (Job, Process, Flow,
Dependencies, External Assoc), entities removed, and entities modified. The latter
include entities that are marked disabled because of having invalid seeded jobs. In
other words, if a custom entity uses seeded jobs (from Oracle) that were removed as
part of the latest schedule version, then the respective custom entities are marked
disabled.
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•  View Logs - Use this button to view the schedule import log for the selected schedule.
The log displays the list of activities completed as part of the schedule import along
with the status, timestamp and other information such as success log, error message,
skip reason, and so on).

• Upgrade - Use this button to upgrade the schedule. This button only appears for
schedules for which an upgrade is available.

• Retry - Use this button to retry a failed update. This button only appears for schedules
that have not completed successfully. The retry will resume the upgrade from the failed
step.

• Cancel - Use this button to cancel the upgrade for an ongoing upgrade as long as it's
in stage 4 or less, or to cancel an upgrade in an error state.
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When an ongoing upgrade is cancelled, it is marked as Error. The user can then either
click the Cancel button again to remove the attempted upgrade so it can be started
over, or click the Retry button to resume the upgrade from the failed step.

•  Skip Failed Stage - Use this button to skip the current stage at which the schedule
upgrade has failed. This is usually done if the upgrade process is at a stage after the
upgrade and you want to ignore failures such as Health Check for now, as you intend
to address it later.

• Restore - Use this button to downgrade/restore to a previous version of the schedule.

5. Download files menu - Use this menu to download schedule files. See Download Files for
more information.

Download Files
Click on the ellipses then select from the download files menu to download files for an upgrade
version. This menu has the following options:

• Download Previous Configuration

• Download POM Seed File

Download Previous Configuration
Use the Download Previous Configuration option to download a file containing the specific
schedule version configurations. This file is in JSON format.

Download POM Seed File
Use the Download POM Seed File to download an SQL file with POM seed data for the
specific schedule version.

Footer
The screen can be set to auto refresh periodically by selecting the pre-defined interval from the
Auto Refresh list. By default, this value is set to 30 minutes on page load which means the
Auto Refresh is turned off.

Use the Refresh button to refresh the screen immediately.

Last refreshed shows the time and date of the last refresh of the interface.
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AMS Utilities
The AMS Utilities are functions performed only by the Oracle administrators.

Select AMS Utilities from the Tasks menu to display the submenu.
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The AMS Utilities submenu contains the following tasks:

• Manual Job Run

• Override Job Status

• Override Execution Request Status

• Audit Events

• Align Business Dates

• Skip Recurring Flow(s)

Manual Job Run
An Oracle administrator uses the Manual Job Run utility to run a job for a particular schedule
from either the Nightly or Hourly cycle. Once the selections are made, the user clicks on Run to
submit the job for execution. The user then uses the Batch Monitoring screen to monitor the
execution of the job.

Note

A job that is manually run on this UI is run standalone without regard to dependencies.

Figure 2-64    Manual Job Run

Override Job Status
The next AMS Utility is Override Job Status.

Occasionally, a job in POM gets stuck with a status where manual intervention is needed. This
is to reset the status and get the job running for instance. This screen is used for this purpose.
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Figure 2-65    Override Job Status

Select the schedule and the cycle to display all jobs for those selections in the Jobs table.

In the table, select the row for the job you intend to override the status for and click the
Change Status button or select Change Status from the table's Actions menu. The Change
Status popup is displayed.

You are required to enter a comment justifying overriding the job's status.
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Notice the warning message. An administrator needs to understand the impact of overriding
the status as it may lead to data corruption if an unintended action takes place.

Override Execution Request Status
The next AMS Utility is Override Execution Request Status.

Occasionally, a job in the POM's Execution Engine gets stuck with a status where manual
intervention is needed. This is to reset the status and get the job running for instance. This
screen is used for this purpose.

Figure 2-66    Override Job Execution Status

Select the schedule and the cycle to display all jobs for those selections in the Jobs table.

Select the row in the Details table for which you intend to override the status and click the
Change Status button or select Change Status from the table's Actions menu. The Change
Status popup is displayed.
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You are required to enter a comment justifying overriding the job's current status.

Notice the warning message. An administrator needs to understand the impact of overriding
the current status as it may lead to data corruption if an unintended action takes place.

Audit Events
An Oracle administrator uses the Audit Events utility to view the list of audit events associated
with the selected schedule. Whenever the system or user triggers any of the actions listed
below, a corresponding audit event is created with the related details.

Here’s a sample screen listing some sample audit events. The audit events can be filtered
based on the following:

• Schedule Name

• Event Type

• Event Severity – High / Medium / Low
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The actions that trigger an audit event are listed below:

# Screen Actions

1 Batch Monitoring • Manual Close/Create/Restart scheduler day
• Job actions (Run/Hold/Skip and so on) 
• Enabled/Disable Scheduler
• Suspend/enable the Schedule
• Schedule task creation or manual run
• Enable/disable dependencies
• Manual Flow Run
• Manual Process Run
• Cycle Recover
• Update Job Parameter

2 Batch Administration • Enable/Disable Jobs 
• Job configuration update 
• MDF Sync
• Export/Import configuration 

– Schedule Config
– Custom Entities 

• Custom Batch Entity (Create/Update/Delete)
• Enabled/Disable Invokable
• Enable All/ Disable All action

3 System Configuration • Update environment settings (URLs)
• Update / Remove external configuration
• Update System settings
• Create/Update/Delete of custom job type
• New Schedule Creation
• System Option Update

4 Scheduler
Administration

• Enable/disable a scheduler task
• Configuration update
• Scheduler Task delete
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# Screen Actions

5 Schedule Maintenance • Schedule upgrade

6 AMS Utilities • Manual job run
• Exec request status update
• Job status update
• Align business date
• Skip Recurring Flow(s)

Align Business Dates
An Oracle Administrator uses Align Business Dates to align the business dates for the
schedules.

The Schedules Configuration screen shows all available schedules and their statuses.

Select the Schedule Name and click the Align Business Date button to align the business
date for a schedule.
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Select a Business Date, add Comments and click the OK button to align that business date
for the selected schedule.

Optionally, toggle the Advance Date Only switch to enforce only business date advancement
for the selected schedule and for the dependent schedules if applicable. You can also toggle
the Update Dependent Schedules switch to enforce business date alignment for all inter-
schedule dependent schedules and for schedules linked through execution links.

Skip Recurring Flow(s)
An Oracle Administrator uses Skip Recurring Flow(s) to skip a flow in a specific hourly cycle
or in all hourly cycles.

Figure 2-67    Skip a Single Hourly Cycle
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Figure 2-68    Skip a Range of Hourly Cycles

Select a Schedule, a Flow for the selected Schedule, a Single or Range of Cycle(s), add
Comments and click the Skip button to skip the specified cycles of the recurring flow.

Data Migration
POM includes a Data Migration feature that allows certain retail users to refresh data from one
environment to another. This feature is under an incremental development and, at this point,
only available to the Retail Analytics and Planning (RAP) customers. An administrative user
can request an ADW Clone to be performed from one environment to another; for example,
production to stage. This feature is accessible through the Data Migration option of the POM
Tasks menu.

This menu option is available only to users that are assigned to the following roles:

Table 2-3    Data Migration Operations – Roles and Privileges

Role Privileges

DM_ADMINISTRATOR_JOB Retailer administrators who can perform all
actions on the Data Migration Configuration
and Operations screens.

DM_MONITOR_JOB Retailer users who can only view and restart
data migrations that are in progress. Users in
this role cannot initiate new migrations.

Select Data Migration from the Tasks menu to display the submenu.
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The Data Migration submenu contains the following tasks:

• Configuration

• Operations

Configuration
The Configuration screen displays all Data Migration Agent Configurations and their details –
Cod Name, Cod Description, URL, Products, Status, and Info. The Info column gives more
information on the status of the configuration.
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Figure 2-69    Data Migration Agent Configuration

Operations
POM users with the right privilege can perform data migration operations such as scheduling
data migration processes, restarting them, and so on. This enables the users to perform the
data migration processes from the POM application itself.

Figure 2-70    Data Migration Operations – Landing Page

The landing page displays a Data Migration Services drop down of available data migration
services.
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Figure 2-71    List of Data Migration Operations

The type of data migration performed is based on the selected Data Migration service and the
product.

For example:

• Retail Analytics and Planning Data Migration (Product: RAP)

Active Migration
Once the user selects a Data Migration Service, a table of Active Migrations and their details is
displayed for the selected Data Migration Service. The migration processes can be either in
Loaded, Started, Completed, Error or Failed status.

Chapter 2
Data Migration

User Guide
G38769-01
Copyright © 2025, Oracle and/or its affiliates.

July 23, 2025
Page 123 of 143



Figure 2-72    List of Active Migration Process Details

The user can select a Data Migration Process then click the View Detail button to view more
details for the process, its stages, and logs. The Details window displays the information based
on the status of the process.

Active Migration – View Detail

Figure 2-73    Detail of Data Migration Process in Completed Status – Process Stages
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Figure 2-74    Detail of Data Migration Process in Completed Status – Process Details –
Operation: ADW_CLONE_APPLY

Figure 2-75    Detail of Data Migration Process in Completed Status – Process Logs –
Operation: ADW_CLONE_APPLY

Figure 2-76    Detail of Data Migration Process in Error Status
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Figure 2-77    Detail of Data Migration Process in Failed Status

The user can restart a failed Data Migration Process by selecting the failed process and
clicking the Restart button. A pop-up window is displayed, prompting for a comment explaining
the restart.

Active Migration – Restart Migration
The user can restart a failed data migration process either by retrying the current failed step or
by skipping the current failed step.

Figure 2-78    Restarting Data Migration Process - Error
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Figure 2-79    Restarting Data Migration Process - Failed

Once the Restart button is clicked, the failed Data Migration Process is restarted based on the
selected option and moved to the appropriate status.

Figure 2-80    Detail of Data Migration Process After Restart - Loaded Status
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Figure 2-81    Detail of Data Migration Process After Restart – Moved to Completed
Status

Active Migration – Cancel Migration
The user can cancel an incomplete data migration (Loaded, Failed, Error, and so on) by
selecting the process and clicking the Cancel Process button.

Figure 2-82    Cancel Process

Create New Migration – Configuration – ADW Cloning
A user can perform an ADW Clone from a source-to-target environment based on the selected
clone type and schedule for Retail Analytics and Planning Data Migration. Once the clone is
applied on the target environment, the previous version of data will be available for seven days
in case a restore is needed. The previous version is discarded after seven days.

Note

Currently, POM only supports cloning when the source and destination environments
are running the same application version. In the future, Oracle will look at removing
this restriction if technically feasible.
Also, POM currently does not support cloning of integrated environments where
Golden Gate is enabled.

The ADW Clone can be performed by clicking the Create New Migration button from either
Active or Scheduled tabs. This opens the Create New Migration window where the user can
first select the process to be migrated along with the operation to be performed on it.
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As mentioned previously, at this point, only the ADW Clone operation is available.

Figure 2-83    Create New Migration – Configuration – ADW Cloning

The user can select either Current State or Point in Time to initiate the cloning of data as of
the current state or cloning of data as of a chosen timestamp, respectively. If Point in Time is
selected, a date and time no older than 60 days must be chosen.

Figure 2-84    Create New Migration – Configuration – Current State
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Figure 2-85    Create New Migration – Configuration – Point in Time

Create New Migration - Scheduling
After providing all the configuration information and clicking the Next button at the bottom of
the Configuration screen, a dialog opens where the data migration can be scheduled. This can
be scheduled to immediately run once, or once later at a scheduled time, or in a recurring
manner. Once a scheduled migration is triggered, it will be listed on the Active Migration tab
where it can be monitored.

Figure 2-86    Create New Migration – Scheduling – Set Up Recurring Schedule

A data migration can be configured in one of many frequencies as described in the table
below:
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Frequency Description

Daily Run daily at the specified time

Weekly Run every <day of a week> at the specified time.

Monthly (By Date) Run on a particular day of each month at a specified
time; for example, on the 15th of each month at
10pm.

Monthly (First Day of the Month) Run at the beginning of every month.

Monthly (Last Day of the month) Run at the end of every month.

Figure 2-87    Create New Migration – Scheduling – Once Now

If Once Now is selected and the Create button is clicked, the migration will be listed in the
Active Migration tab in Loaded status and ready to be executed. The process then moves to
Started then Completed/Error status.
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Figure 2-88    Create New Migration – Scheduling – Once Later

If Once Later is selected, a data migration is scheduled and run once on the selected date and
time.

Figure 2-89    Create New Migration – Scheduling – Recurring - Daily
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Figure 2-90    Create New Migration – Scheduling – Recurring - Weekly

Figure 2-91    Create New Migration – Scheduling – Recurring – Monthly (by Date)
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Figure 2-92    Create New Migration – Scheduling – Recurring – Monthly (First Day of
Month)

Figure 2-93    Create New Migration – Scheduling – Recurring – Monthly (Last Day of
Month)

After the Data Migration Process is configured and scheduled, the user can click the Create
button to create the process. A confirmation pop up is displayed, after which the process is
created.
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Figure 2-94    Create New Migration – Confirmation

Once the process is created, the Scheduled Migration screen is shown where the created
process is listed in the Scheduled Migration table.

Scheduled Migration

Figure 2-95    Scheduled Migration

The new process can also be seen in the Activity Feed in the right panel of the Scheduled
Migration tab. If the created process does not show immediately, click the Refresh icon to see
it.
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Figure 2-96    Scheduled Migration – Activity Feed

Scheduled Migration - Detail
The Scheduled Migration table also lists the other data migration processes that are
scheduled. The status of the process can either be in Scheduled, Cancelled, Skipped On
Delay, or Completed.

Scheduled Migration – Edit
The user can reschedule a process that either in Cancelled or Skipped on Delay status by
selecting the corresponding row and clicking on the Edit icon. The process can be rescheduled
to immediately run once, or once later at a scheduled time, or in a recurring manner by
selecting the Frequency. Once rescheduled, the process moves to Scheduled status.
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Figure 2-97    Scheduled Migration – Edit Process

Scheduled Migration – Stop
A scheduled data migration process can be stopped by selecting a process that is in
Scheduled status and clicking the Stop button. After confirming the action, the process is
moved to ‘Cancelled’ status.

The cancelled process can be scheduled again by clicking the Edit icon and rescheduling it.

Figure 2-98    Scheduled Migration – Stop Process

Reports
Select Reports from the main menu to display the submenu.
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Nightly Batch Summary
The Nightly Batch Summary displays a configurable Batch Summary report, which displays
Nightly cycle statistics across select schedules.

Click the Options button to select the month and schedule(s) for which the report is to be run.
All the schedules are populated by default and can be added or removed as needed. The
Switch to Current Month button resets the summary report to the current month.
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The statistics displayed as tiles are,

• Total Failures

• Average Duration

• Zero Failure Days

• Target Misses for the current and previous month

A red icon in the top left corner indicates that the statistics count is a serious concern that
needs to be addressed. A blue icon indicates a neutral status and green icon indicates an
acceptable failure count.

Tile# 1 – Total Failures

This tile displays the total batch failures for the selected month and schedules. The previous
month’s failure count is also displayed for comparison.
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Tile# 2 – Average Duration

This tile displays the average duration of a batch cycle for the selected month and schedules.
The previous month’s average duration is also displayed for comparison.

Tile# 3 – Zero Failure Days
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This tile displays the count of the days when a batch completed execution without any failure
for the selected month and schedules. The previous month’s Zero failures count is also
displayed for comparison.

Tile# 4 – Target Misses

The Target Batch Duration is a threshold that can be set at the schedule level at provisioning
time. It can also be added or modified on the System Options screen accessed from the
System Configuration screen. This system option’s key is TARGET_BATCH_DURATION. A target
miss occurs when batch duration for a schedule exceeds this threshold. The Target Misses tile
displays the miss count for the month along with the respective Arrow icon color.

Batch Timings Bar Graph

The Batch Timings bar graph by date, shows the Schedule Name(s) in the right margin, along
with a bar for each day of the month. Each bar represents a stacked nightly batch duration per
schedule for that day.
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Batch Failures

The Batch Failures section of the report provides the total batch failures on a weekly basis for
the selected schedules and month.

Batch Jobs Timeline
The Batch Jobs Timeline report displays the timeline of the jobs executed for the selected
Business Date, Schedule, and Cycle. The Batch Jobs Timeline can also be accessed by
clicking the Download Cycle Summary button, then Open Report from the Batch Monitoring
screen for a completed schedule.
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3
User Roles

Roles are used to classify users based on job responsibilities and actions to be performed in
the Oracle Retail Process Orchestration and Monitoring application (POM). Using roles, a
user's access can be restricted to specific areas or functions within the application. In POM,
users must be associated with at least one job role in order to access the application.

The following topics are covered in this chapter:

Roles

Functional Access by Role

Roles
POM comes available with a set of pre-defined roles described in the table below. In addition to
the roles, the table contains an alias for each role which is used in the next section for easier
reading.

Table 3-1    Roles

Role Alias Description

BATCH_ADMINISTRATOR_JOB Administrator Users within this role are retailer
administrators with full access to all
POM actions. They monitor, maintain
and configure the batch schedules. They
may also maintain POM application
configurations for efficient operations.
They troubleshoot batch issues and
work with Oracle support personnel to
address those issues. Finally, they may
apply batch schedule patches and
upgrades.
Additionally, users assigned this role
are given access to the Oracle AMS
Utilities screen.

BATCH_VIEWER_JOB Viewer Users within this role are retailer
business users responsible for just
monitoring batch. They have view
access to all POM screens except AMS
Utilities.

BATCH_SCHEDULE_CONFIGURATIO
N_MANAGER_JOB

Schedule Config
Mgr

Users within this role are typically
retailer administrators responsible for
just monitoring batch and configuring
external dependencies and callbacks
into the Company's systems. They have
view access to all POM screens except
AMS Utilities.
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Table 3-1    (Cont.) Roles

Role Alias Description

BATCH_SCHEDULE_ADMINISTRATO
R_JOB

Schedule Admin Users within this role are typically
retailer administrators responsible for
maintaining, monitoring and executing
batch. They have view access to all POM
screens except AMS Utilities. They can
perform select activities on the Batch
Monitor screen to move the schedule
along. They also have update access to
the Batch Administration screen. They
can also configure some application
properties and can configure a new
schedule

BATCH_ORACLE_AMS_ADMINISTRA
TOR_JOB

AMS Admin Users within this role are typically
Oracle AMS administrators who
monitor, maintain and configure the
batch schedules. They also maintain
POM application configurations for
efficient operations. They troubleshoot
batch issues and work with other
Oracle development and support
personnel to address those issues.
Finally they apply POM and batch
schedule patches and upgrades.

DM_ADMINISTRATOR_JOB DM Admin Users within this role are typically
retailer administrators responsible for
migrating data from one environment
to another. They can perform all actions
on the Data Migration Configuration
and Operations screens.

DM_MONITOR_JOB DM Monitor Users within this role are retailer
business users responsible for just
monitoring data migrations. They can
only view and restart data migrations
that are in progress. They cannot
initiate new migrations.

Functional Access by Role
This section lists all roles that have update access for each functional aspect of every screen.
It is organized by screen, except for the first two tables.

Table 3-2    External Integration

Feature Roles (aliases) with access

Invoking batch execution
from an external system
Requesting the status of a
batch execution
Releasing dependency on an
external process

Schedule Admin
Administrator
AMS Admin
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Table 3-3    POM Task Menu

Feature Roles (aliases) with access

Show Batch Monitoring task Administrator
Viewer
Schedule Config Mgr
Schedule Admin
AMS Admin

Show System Configuration task Administrator
Viewer
Schedule Config Mgr
Schedule Admin
AMS Admin

Show Batch Administration task Administrator
Viewer
Schedule Config Mgr
Schedule Admin
AMS Admin

Show Scheduler Administration task Administrator
Schedule Admin
AMS Admin

Show Schedule Maintenance task Administrator
Viewer
Schedule Config Mgr
Schedule Admin
AMS Admin

Show AMS Utilities task AMS Admin

Table 3-4    Screen: Batch Monitoring

Feature Roles (aliases) with update access

Buttons for Create Schedule, Close Schedule
and Restart Schedule

Schedule Admin
Administrator
AMS Admin

Jobs table on Batch Monitoring screen - Buttons
for Run, Rerun, Hold, Release, Skip, Release
Skip, and action for Add Comments

Schedule Admin
Administrator
AMS Admin

Jobs table Actions menu on Batch Monitoring
screen - Edit Parameters (for selected job)

Schedule Admin
Administrator
AMS Admin

Job Details screen - Enable/Disable External
Dependencies

Administrator
Schedule Config Mgr
Schedule Admin
AMS Admin
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Table 3-4    (Cont.) Screen: Batch Monitoring

Feature Roles (aliases) with update access

Job Details screen - Retry Schedule Link button Administrator
AMS Admin

Job Details screen - Retry Callback button Administrator
AMS Admin

Execution Engine display Configuration Administrator
AMS Admin

Download Job Log All authenticated users

Download Cycle Summary All authenticated users

Scheduler Tasks Monitoring and actions Administrator
Schedule Admin
AMS Admin

Table 3-5    Screen: System Configuration

Feature Roles (aliases) with update access

System tab - Update actions Administrator
AMS Admin

Schedule tab - Update actions for general &
environment settings

Administrator
AMS Admin

Schedule tab - Job agent system options dialog Administrator
AMS Admin

Schedule tab - Update actions for MDF
configuration

Administrator
AMS Admin

Schedule tab - Update actions for job agent
throttling configuration

Administrator
AMS Admin

System tab - Update actions for external
configurations

Administrator
Schedule Config Mgr
Schedule Admin
AMS Admin

Global Edit - Settings updates Administrator
AMS Admin

Global Edit - External Configuration updates Administrator
Schedule Config Mgr
Schedule Admin
AMS Admin

Configure New Schedule Administrator
Schedule Admin
AMS Admin
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Table 3-6    Screen: Batch Administration

Feature Roles (aliases) with update access

Export Config and Import Config buttons Administrator
Schedule Admin
AMS Admin

Enable/disable switch on each of the Recurring
Flows and Jobs within each Flow

Administrator
Schedule Admin
AMS Admin

Jobs table on main UI - Edit and Enable/Disable
actions

Administrator
Schedule Admin
AMS Admin

Batch Job Details - Enable/Disable
Dependencies

Administrator
AMS Admin

Batch Job Details - Create/Enable/Disable/Delete
Inter-Schedule Dependencies

Administrator
AMS Admin

Batch Job Details - Create/Enable/Disable/Delete
Schedule links

Administrator
AMS Admin

Batch Job Details - Create/Enable/Disable/Delete
External Dependencies

Administrator
Schedule Config Mgr
Schedule Admin
AMS Admin

Create/Edit/Delete Custom Adhoc Entities Administrator
Schedule Admin
AMS Admin

Table 3-7    Screen: Scheduler Administration

Feature Roles (aliases) with update access

All Functions on the Scheduler Administration
screen

Administrator
Schedule Admin
AMS Admin

Table 3-8    Screen: Schedule Maintenance

Feature Roles (aliases) with update access

All actions: Import Latest Schedule button,
Upgrade, Retry buttons in table row
Download Configuration and download POM
seed data

Administrator
AMS Admin
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Table 3-9    Screen: AMS Utilities

Feature Roles (aliases) with update access

Manual Job Run
Override Job Status
Override Execution Request Status
View Audit Events
Align Business Dates
Skip Recurring Flow(s)

Administrator
AMS Admin

Table 3-10    Screen: Application Properties

Feature Roles (aliases) with update access

Application Properties Schedule Admin
Administrator
AMS Admin

Table 3-11    Screen: Data Migration

Feature Roles (aliases) with update access

All actions: Agent Configuration, All Data
Migration operations

DM Admin

View data migrations in progress, Restart failed
migrations

DM Monitor
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